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Understanding the Creative Economy 

What Is the Creative Economy? 

The creative economy refers to the part of the global economy built around the creation, production, and 

distribution of creative ideas and content. It includes music, film, photography, writing, design, 

animation, and digital content creation. Thanks to the internet, anyone with a smartphone and an idea can 

become a creator, meaning this economy isn’t limited to artists or professionals. Examples of Creative 

Economy Activities: 

• Posting videos on YouTube or TikTok 

• Sharing photography and designs on Instagram or Pinterest 

• Writing blogs or eBooks 

• Producing podcasts or livestreams 

• Designing digital products like filters, templates, or courses 

 

Why the Creative Economy Matters 

• Builds personal brands and online careers 

• Promotes small businesses and products 

• Shares local culture globally 

• Encourages entrepreneurship and independence 

• Develops storytelling and marketing skills 

 

Platforms That Pay Creators 

Platform Main Content Type How Creators Earn 

YouTube Videos, tutorials Ads, memberships, brand deals 

TikTok Short videos Creator rewards, live gifts 

Instagram Photos, Reels Brand partnerships, affiliate sales 

Facebook Mixed media In-stream ads, fan subscriptions 

X (Twitter) Text & videos Ad-revenue sharing 
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Patreon / BuyMeACoffee Fan content Subscriptions, donations 

Table 1: Platforms That Pay Creators 

How to open a Gmail account 

Gmail is Google’s free email service that allows you to send, receive, and organize emails easily. 

Creating a Gmail account also gives you access to all Google services: like YouTube, Google Drive, 

Maps, and Google Photos. Follow these simple steps: 

Step 1: Go to the Gmail Website 

Open your web browser and go to: www.gmail.com 

You can also do this on your phone or computer. 

Step 2: Click “Create Account” 

On the Gmail page: 

• Click Create account. 

• Choose one of the options: 

o For myself – for personal use 

o For my child – if setting up for a child 

o For work or my business – for business use 

Step 3: Fill In Your Personal Information 

A form will appear asking for: 

1. First name and last name 

2. Username (this becomes your Gmail address, e.g. yourname@gmail.com) 

3. Password and Confirm password 

Make sure your password is strong: use letters, numbers, and symbols. 

Then click next. 

Step 4: Add Recovery Details 

Google will ask for: 

https://www.gmail.com/
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• Phone number (optional but useful for password recovery) 

• Recovery email (optional) 

• Date of birth and Gender 

After entering, click next. 

Step 5: Verify Your Phone Number (Optional) 

If you added a phone number: 

• Google will send a 6-digit verification code via SMS. 

• Enter the code and click Verify. 

Step 6: Agree to Google’s Terms 

Read through Google’s Privacy and Terms page, then click I agree to continue. 

Step 7: Welcome to Gmail! 

Your account is now ready!  You’ll be automatically signed in and taken to your new Gmail inbox. 

Step 8: Set Up Your Gmail 

You can now: 

• Add a profile picture 

• Explore the settings gear     to customize your inbox 

• Start sending and receiving emails 

Tips for Beginners 

• Bookmark www.gmail.com for quick access. 

• Always log out if you’re using a shared or public computer. 

• Check the Spam folder occasionally for missed messages. 

• Use Labels and Folders to organize your emails. 

• Download the Gmail app for easy mobile access. 

 

https://www.gmail.com/
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How to open a Youtube account 

Creating a YouTube account is simple and free. With just a few steps, you can start watching, liking, 

subscribing, and even uploading your own videos. Follow this guide to get started: 

Step 1: Sign in to Google 

YouTube is a Google service, so you’ll need a Google account (Gmail) to use it. 

1. Go to www.google.com. 

2. Click Sign in (top right corner). 

3. If you already have a Gmail account, sign in using your email and password. 

4. If not, click Create account → choose for myself or to manage my business. 

5. Follow the prompts to set up your Google account. 

Step 2: Go to YouTube 

1. Visit www.youtube.com. 

2. Click Sign in (top right corner). 

3. Sign in using your Google account details. 

Once signed in, your Google account automatically becomes your YouTube account. 

Step 3: Create Your YouTube Channel 

To upload videos or customize your YouTube presence, you’ll need a personal or brand channel. 

1. Click your profile picture (top right corner). 

2. Select create a channel. 

3. Enter your name or a custom channel name (if you’re creating a brand or organization account). 

4. Upload a profile picture and write a short description if you wish. 

5. Click Create Channel. 

Step 4: Customize Your Channel 

Make your channel attractive and unique. 

• Add a profile picture (logo or your photo). 

• Upload a banner image (a wide picture that represents your brand or content). 

• Write an “About” section describing what your channel is about. 

• Add links to your website or social media if applicable. 

https://www.google.com/
https://www.youtube.com/
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Step 5: Explore and Start Uploading 

Now that your channel is ready: 

1. Click the Create (+) button (top right corner). 

2. Choose Upload video. 

3. Follow the steps to upload your first video. 

4. Add a title, description, and tags to help people find your video. 

5. Set your video visibility (Public, Unlisted, or Private). 

6. Click Publish. 

Step 6: Engage and Grow 

• Subscribe to other channels. 

• Comment on videos. 

• Share your videos on social media. 

• Stay active to grow your audience. 

Download the YouTube Studio app on your phone to manage your videos, check views, reply to 

comments, and track your growth easily. 

 

How to open an Instagram account  

Instagram is a free social media platform for sharing photos, videos, and connecting with friends, family, 

or customers. Follow these simple steps to create your own Instagram account. 

Step 1: Download the Instagram App 

You can create an Instagram account on your smartphone or computer. 

• On Mobile: 

✓ Go to Google Play Store (Android) or App Store (iPhone). 

✓ Search for Instagram. 

✓ Tap Install (Android) or Get (iPhone). 

• On Computer: 

✓ Visit www.instagram.com using your web browser. 

Step 2: Open the App or Website 

https://www.instagram.com/
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After installation or visiting the site: 

• Tap Sign up (on mobile) 

or click Sign up (on desktop). 

Step 3: Choose How to Sign Up 

You can sign up using: 

1. Your email address 

2. Your phone number 

3. Your Facebook account (optional) 

Then: 

• Enter your full name, username, and password. 

• Tap Next. 

Step 4: Complete Your Profile 

Once your account is created: 

1. Add a profile photo (your picture or logo). 

2. Write a short bio (a short description about you or your brand). 

3. Optionally, add a website link or contact information. 

Tap done to save your profile. 

Step 5: Start Following and Exploring 

• Follow friends, family, or pages you like. 

• Use the search icon 🔍 to find people or topics. 

• Tap      to like posts. 

• Tap 💬 to comment or share. 

Step 6: Post Your First Photo or Video 

1. Tap the (+) Plus icon at the bottom center. 

2. Choose a photo or video from your gallery. 
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3. Add a caption, location, or hashtags (like #travel #food). 

4. Tap Share. 

Step 7: Secure Your Account 

• Go to Settings → Privacy and Security. 

• Turn on Two-factor authentication for extra protection. 

• Choose whether to make your account Public or Private. 

Tips for Beginners 

• Keep your username simple and recognizable. 

• Use a clear, bright profile photo. 

• Post regularly to engage your followers. 

• Explore Instagram Stories and Reels for more fun and reach. 

 

How to open a BuyMeACoffee account 

Buy Me a Coffee is an easy platform where creators, freelancers, and entrepreneurs can receive support or 

donations (“coffees”) from their audience. You can use it to collect tips, sell digital items, or set up 

memberships. Follow these steps to create your account: 

Step 1: Visit the Website 

Go to www.buymeacoffee.com using your phone or computer browser. 

Step 2: Click “Sign Up” 

On the homepage, click the Sign up button at the top right corner. 

You can sign up in three ways: 

1. Using your Google account 

2. Using your Apple ID (if on iPhone or Mac) 

3. Using your Email address 

Choose your preferred method and follow the prompts. 

https://www.buymeacoffee.com/
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Step 3: Create Your Page 

Once signed up, you’ll set up your Buy Me a Coffee page: 

1. Choose a username (e.g. buymeacoffee.com/yourname). 

2. Add your display name (this is what supporters see). 

3. Upload a profile photo or logo. 

4. Write a short bio introducing who you are and what you do. 

5. Click Next to continue. 

Step 4: Set Up Payments 

To receive money, connect your preferred payment method: 

• Click “Connect payout” 

• Choose Payoneer, Stripe, or Bank Transfer (depending on your country). 

• Follow the instructions to complete setup. 

PayPal is no longer supported for new users, so choose one of the available methods. 

Step 5: Customize Your Page 

Make your page unique and appealing: 

• Add a cover image (like a banner). 

• Set your coffee price (default is $5, but you can change it). 

• Add a goal (e.g., “Raising $100 for new camera equipment”). 

• Include links to your social media or website. 

Step 6: Share Your Link 

Your page link will look like this: www.buymeacoffee.com/yourname 

Share it on: 

• Social media (Instagram bio, YouTube description, Facebook page) 

• Your website or blog 

• Email signature 

This is how people send you support. 

http://www.buymeacoffee.com/yourname
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Step 7: Explore Extra Features 

• Memberships: Offer exclusive content or perks to monthly supporters. 

• Posts: Write updates or share behind-the-scenes content. 

• Shop: Sell digital items (like PDFs, courses, templates, or art). 

Tips for Success 

• Add a friendly photo and short, personal bio. 

• Be clear about what supporters are contributing to. 

• Say thank you to each supporter! 

• Post regularly to keep your audience engaged. 

 

How to open a Facebook account  

Facebook is one of the most popular social media platforms where you can connect with friends, share 

updates, join groups, and promote your business. Creating an account is free and easy: here’s how to do 

it: 

Step 1: Go to Facebook 

You can create a Facebook account using either a phone or computer. 

• On mobile: Download the Facebook app from Google Play Store (Android) or App Store 

(iPhone). 

• On computer: Visit www.facebook.com. 

Step 2: Click or Tap “Create New Account” 

Once you open the app or website, click Create new account. 

A form will appear asking for your details. 

Step 3: Enter Your Information 

Fill in the required details: 

https://www.facebook.com/
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1. First name and surname 

2. Mobile number or email address 

3. Password (create a strong one) 

4. Date of birth 

5. Gender 

Then tap Sign Up. 

Step 4: Confirm Your Account 

Facebook will send you a verification code to your: 

• Email (if you signed up with email), or 

• Phone number (if you signed up with phone). 

Enter the code to verify and activate your account. 

Step 5: Set Up Your Profile 

Once your account is confirmed, personalize your profile: 

1. Add a profile picture (your photo or logo). 

2. Upload a cover photo (a wide image that represents you). 

3. Write a short bio about yourself. 

4. Add your education, workplace, or hometown (optional). 

Tap Save when done. 

Step 6: Find Friends 

• Use the search bar to find friends or family. 

• Send friend requests by tapping Add Friend. 

• Facebook may also suggest people you may know. 

Step 7: Start Using Facebook 

Now you can: 

• Post status updates, photos, or videos. 

• Like, comment, and share posts. 
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• Join Facebook Groups or create a Page for your business, church, or organization. 

• Use Messenger to chat privately with friends. 

Step 8: Secure Your Account 

• Go to Settings → Privacy and Security. 

• Turn on Two-factor authentication. 

• Review Who can see your posts and set privacy levels as you prefer. 

Tips for New Users 

• Use your real name for easier identification. 

• Avoid sharing personal information publicly. 

• Always log out after using a shared device. 

• Keep your password private and strong. 

 

How to open an X account  

X (formerly Twitter) is a social media platform where you can share short posts (called posts or tweets), 

follow news, connect with people, and build your personal or business brand. Follow these easy steps to 

create your account: 

Step 1: Go to the X Website or App 

You can open an X account on your phone or computer. 

• On Mobile: 

✓ Go to Google Play Store (Android) or App Store (iPhone). 

✓ Search for X (formerly Twitter) and install it. 

• On Computer: 

✓ Visit www.x.com or www.twitter.com. 

Step 2: Click “Create Account” 

On the homepage, click or tap Create account. 

You’ll see a sign-up form where you can enter: 

https://www.x.com/
https://www.twitter.com/
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1. Your name 

2. Phone number or email address 

3. Date of birth 

Then tap next. 

Step 3: Customize Your Experience 

You may be asked if you want to: 

• Allow X to personalize your experience (optional). 

• Accept terms and conditions. 

Tap next again. 

Step 4: Verify Your Account 

X will send a verification code to your email or phone number. 

• Enter the code in the box provided. 

• Tap Next to confirm your account. 

Step 5: Create a Password 

Choose a strong password that you’ll remember. 

Tap Next to continue. 

Step 6: Set Up Your Profile 

Now you can make your profile unique: 

1. Add a profile picture (your photo or logo). 

2. Write a short bio about yourself or your work. 

3. Add a location and website (optional). 

4. Upload a header photo (a wide banner image). 

Tap Save when done. 

Step 7: Follow Accounts 
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X will suggest popular accounts or topics. 

• Tap Follow on people, organizations, or topics you like. 

• You can always follow or unfollow later. 

Step 8: Post Your First Tweet (Post) 

1. Tap the Post (+) button. 

2. Type a message (up to 280 characters). 

3. Add a photo, video, or link if you like. 

4. Tap Post to share it. 

Step 9: Secure Your Account 

• Go to Settings → Privacy and Safety. 

• Enable Two-factor authentication. 

• Review who can see and reply to your posts. 

Tips for New Users 

• Keep your posts short, clear, and engaging. 

• Use hashtags (#) to reach more people. 

• Follow others to grow your network. 

• Avoid sharing personal or sensitive information publicly. 

• Stay kind and professional, your posts are public! 

 

 

 

How to open a Patreon account 

Patreon is a platform where creators, artists, writers, and educators can earn income directly from their 

fans or supporters through subscriptions and memberships. 

Here’s how to create your own Patreon account: 
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Step 1: Visit the Patreon Website 

Go to www.patreon.com using your phone or computer browser. 

Step 2: Click “Sign Up” 

On the homepage, click Sign Up (top right corner). 

You can sign up using: 

1. Google account 

2. Apple ID 

3. Email address and password 

Choose your preferred option and follow the prompts. 

Step 3: Verify Your Email 

If you signed up with your email, Patreon will send a verification link to your inbox. 

• Open the email and click Verify Email Address. 

• This activates your Patreon account. 

Step 4: Choose What You Want to Do 

Once verified, Patreon will ask how you plan to use the platform: 

• Support creators (as a fan), or 

• Start your own page (as a creator) 

To earn from your work, choose “Start my page.” 

Step 5: Set Up Your Creator Page 

You’ll now personalize your Patreon page: 

1. Name your page – Use your real name or brand name. 

2. Add a profile picture – A clear photo or logo. 

3. Write a bio/description – Tell supporters who you are and what you create (e.g., music, art, 

tutorials, podcasts, and writing). 

https://www.patreon.com/
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4. Upload a cover image – A wide banner image to make your page attractive. 

5. Choose your category – Select what best describes your content (e.g., Education, Art, Music). 

Click Save and Continue. 

Step 6: Set Up Payment and Tiers 

To receive payments from supporters: 

1. Go to Settings → Payouts. 

2. Connect your PayPal, Stripe, or Bank account (depending on your region). 

3. Set your currency and payment schedule. 

You can also create membership tiers, such as: 

• $3/month – “Supporter” 

• $10/month – “Exclusive Access” 

• $25/month – “VIP Member” 

Each tier can include different rewards or perks. 

Step 7: Preview and Launch Your Page 

Before publishing: 

• Review how your page looks. 

• Edit any details if necessary. 

• When ready, click Launch Page to go live. 

Step 8: Share Your Patreon Link 

Your Patreon page link will look like this: www.patreon.com/yourname 

Share it on: 

• Social media bios 

• YouTube or blog 

• WhatsApp or newsletters 
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Encourage your fans to become patrons and support your work. 

Tips for New Creators 

• Be consistent : post regular updates for your patrons. 

• Offer small rewards or early access to content. 

• Thank your patrons often. 

• Add a clear “Why support me” message on your page. 

• Keep your visuals and description professional. 

 

How to open an Adsense account 

Google AdSense is a free program that allows website owners, bloggers, and YouTubers to earn money 

by displaying ads on their content. When visitors view or click those ads, you earn revenue. Follow these 

simple steps to create your own AdSense account. 

Step 1: Go to the AdSense Website 

Open your web browser and visit: https://www.google.com/adsense/start 

Step 2: Click “Get Started” 

On the AdSense homepage, click the Get Started button. 

You’ll be prompted to sign in with your Google account (Gmail). 

If you don’t have a Gmail account, first create one at www.gmail.com. 

Step 3: Enter Your Website or YouTube Channel 

You’ll see a setup form asking for: 

1. Your website URL (e.g., www.yoursite.com). 

o If you don’t have a website yet, you can connect your YouTube channel after approval. 

2. Choose whether you want customized help and performance suggestions (optional). 

3. Select your country or region. 

Then click Start using AdSense. 

https://www.gmail.com/
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Step 4: Review and Accept Terms 

Read Google’s AdSense Terms and Conditions, then click Yes, I agree to continue. 

Step 5: Provide Your Payment Details 

After signing up: 

1. Enter your name, address, and phone number: this information must be correct for payments. 

2. Click Submit. 

Step 6: Verify Your Website (or Channel) 

To prove that you own the site: 

• Google will give you an HTML code snippet. 

• Copy and paste it into your website’s <head> section. 

• Then click Verify in AdSense. 

If you’re connecting your YouTube channel, verification happens automatically through your Google 

account. 

Step 7: Wait for Review and Approval 

Google will review your site or channel to make sure it meets AdSense policies. 

This process may take a few days to two weeks. 

You’ll receive an email notification once your account is approved. 

Step 8: Add Ads to Your Site or Channel 

Once approved, you can: 

1. Log in to your AdSense dashboard. 

2. Go to Ads → Overview → By site. 

3. Choose Auto ads or Manual ads. 

4. Copy the ad code and paste it into your website. 
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If you’re using YouTube, ads will be managed automatically through your YouTube Studio → 

Monetization section. 

Step 9: Verify Your Address (PIN) 

When your earnings reach about $10, Google will mail you a PIN (Personal Identification Number). 

• Enter this PIN in your AdSense account to verify your address. 

Step 10: Receive Payments 

After your earnings reach $100 USD (or your country’s equivalent), Google will send your payment 

through: 

• Bank transfer (EFT) 

• Wire transfer 

• Cheque (in some regions) 

Payments are usually made monthly. 

Tips for AdSense Success 

• Make sure your site has original, valuable content. 

• Avoid copying other websites’ content. 

• Never click on your own ads: it can get your account banned. 

• Follow Google’s AdSense Program Policies strictly. 

• Track your earnings regularly through the AdSense dashboard. 

 

 

 

How to open a TikTok account 

TikTok is a popular short-video platform where users can create, watch, and share videos with music, 

filters, and effects. You can use it for fun, learning, or promoting your brand or business. Follow these 

simple steps to create your TikTok account: 
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Step 1: Download the TikTok App 

TikTok works best on mobile devices. 

• For Android users: Go to Google Play Store, search for TikTok, and tap Install. 

• For iPhone users: Go to the App Store, search for TikTok, and tap Get. 

Step 2: Open the App 

Once installed, tap the TikTok app icon to open it. 

You’ll see short videos playing on the home screen, you can watch even without an account, but you’ll 

need one to post or interact. 

Step 3: Tap “Sign Up” 

On the bottom-right corner, tap the Profile icon 👤, then tap Sign up. You can sign up using: 

1. Phone number 

2. Email address 

3. Google account 

4. Facebook account 

5. Apple ID (for iPhone users) 

Choose your preferred option. 

Step 4: Enter Your Details 

TikTok will ask for: 

• Your date of birth 

• Phone number or email address (for verification) 

• A password 

Then tap next. 

Step 5: Verify Your Account 

TikTok will send a verification code to your phone or email. 
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• Enter the code in the box provided. 

• Tap Next to confirm and complete registration. 

 

Step 6: Set Up Your Profile 

After verification: 

1. Add a profile photo or video. 

2. Choose a username (this becomes your TikTok handle, e.g. @yourname). 

3. Write a short bio about yourself or your brand. 

4. Link your Instagram or YouTube if you wish. 

Tap Save to finish. 

Step 7: Explore TikTok 

You can now: 

• Watch videos by swiping up or down. 

• Tap      to like, 💬 to comment, and 🔁 to share. 

• Tap the magnifying glass 🔍 to explore trending videos or creators. 

• Follow people you like. 

Step 8: Create Your First Video 

1. Tap the (+) Plus icon at the bottom center. 

2. Record a video using your phone camera or upload one. 

3. Add music, filters, text, or effects. 

4. Write a caption and add hashtags (like #funny or #tutorial). 

5. Choose your privacy settings (Public, Friends, or Private). 

6. Tap Post. 

Step 9: Secure Your Account 

• Go to Profile → Menu → Settings and Privacy. 

• Turn on Two-step verification for security. 

• Review your Privacy settings to control who can comment, duet, or message you. 
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Tips for Beginners 

• Post regularly to grow your audience. 

• Use trending hashtags and sounds. 

• Keep videos short and engaging. 

• Avoid posting copyrighted or inappropriate content. 

• Interact with others to build a community. 

 

How to open a Blogger account 

Blogger is a free platform by Google that allows you to create and manage your own blog without 

needing coding skills. You can write posts, add pictures, and even earn money through Google AdSense. 

Follow these easy steps to create your Blogger account: 

Step 1: Sign in with Your Google Account 

Blogger is a Google service, so you’ll need a Gmail account first. 

1. Go to www.blogger.com. 

2. Click Sign in (top right corner). 

3. Enter your Gmail address and password. 

If you don’t have a Gmail account yet, create one at www.gmail.com. 

Step 2: Create a New Blog 

Once signed in: 

1. Click Create your blog. 

2. A window will appear asking for your blog title (the name your readers will see). 

3. Click Next. 

Step 3: Choose Your Blog Address 

You’ll now create your blog’s web address (URL). 

• Type your preferred name (e.g. myblogname). 

https://www.blogger.com/
https://www.gmail.com/
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• Blogger will automatically make it like: myblogname.blogspot.com 

If the address is available, click next. 

Step 4: Add Your Display Name 

This is the name that appears on your posts as the author. 

• Type your preferred name or nickname. 

• Click Finish. 

You’ve now created your Blogger account and your first blog! 

Step 5: Customize Your Blog 

Make your blog look attractive and personal: 

1. Go to the Dashboard → Theme. 

2. Choose a theme (design) you like and click Apply. 

3. Click Layout to rearrange gadgets (like About Me, Labels, or Archives). 

4. You can also upload your logo or header image. 

Step 6: Write Your First Post 

1. Click the New Post (+) button. 

2. Add a title and start writing your content. 

3. Use the toolbar to: 

• Add images or videos 

• Format text (bold, underline, headings) 

• Add links 

When ready, click Publish to make it live. 

Step 7: Preview and Share Your Blog 

• Click View Blog to see how your site looks. 

• Share your link with friends : it looks like: yourblogname.blogspot.com 

Step 8: Connect to AdSense (Optional) 
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Once your blog has enough quality posts, you can monetize it: 

1. In your Blogger dashboard, click Earnings. 

2. Follow the steps to connect to Google AdSense. 

3. Wait for approval: then ads will appear on your blog, and you’ll start earning. 

Step 9: Manage and Grow Your Blog 

• Post regularly with useful, original content. 

• Add Labels to organize posts. 

• Share your posts on social media. 

• Reply to comments to engage readers. 

Tips for Beginners 

• Use a simple, readable theme. 

• Write clearly and consistently. 

• Avoid copying other people’s content. 

• Use keywords in titles for better search visibility. 

• Keep backups of your posts. 

 

How to open a Wordpress account 

WordPress is one of the world’s most popular platforms for creating websites and blogs. You can use it to 

build anything, from a personal blog to a business website, without needing to know coding. There are 

two main versions: 

• WordPress.com – free and hosted by WordPress (good for beginners). 

• WordPress.org – self-hosted and requires web hosting (for advanced users). 

This guide covers WordPress.com, the easiest way to get started. 

Step 1: Visit the WordPress Website 

Go to www.wordpress.com 

Click “Start your website” or “Get Started.” 
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Step 2: Create an Account 

You’ll be asked to sign up. 

You can register using: 

• Your email address, or 

• A Google account, or 

• An Apple account 

Fill in: 

• Email address 

• Username 

• Password 

Then click “Create your account.” 

Step 3: Choose Your Website Type 

WordPress will ask what kind of site you want: 

• Personal blog 

• Business website 

• Portfolio 

• Online store 

Choose the one that fits your goal, then click Continue. 

Step 4: Pick a Domain Name 

Next, you’ll select your website address (domain). 

Examples: 

• Free domain: yourname.wordpress.com 

• Custom domain (paid): yourname.com 

Choose your preferred domain and click Select. 
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Step 5: Choose a Plan 

WordPress will show several plans: 

• Free – great for beginners (your site will have “.wordpress.com”). 

• Personal, Premium, or Business – paid options with more tools. 

If you’re just starting, click Start with Free. 

Step 6: Set Up Your Site 

Now it’s time to make your site look great! 

In your Dashboard, you can: 

1. Click Design → Themes to choose a template. 

2. Click Customize to change colors, fonts, and layout. 

3. Add a Site Title and Tagline under Settings → General. 

4. Upload a profile photo or logo. 

Step 7: Create Your First Post or Page 

• To create a blog post: Go to Site → Posts → Add New.  Write your title and content, then click 

Publish. 

• To create a page (like “About” or “Contact”): Go to Site → Pages → Add New. 

Step 8: Preview and Share Your Site 

• Click View Site to see how it looks. 

• Copy your site link (e.g. yourname.wordpress.com) and share it with friends or followers. 

Step 9: Manage Your Website 

From your dashboard, you can: 

• Add images, videos, and links 

• Check stats (number of visitors) 

• Moderate comments 

• Connect your site to social media 
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Tips for beginners 

• Keep your design simple and clean. 

• Post regularly to keep readers engaged. 

• Use categories and tags to organize posts. 

• Always check spelling and formatting before publishing. 

• Upgrade later if you want your own domain (e.g. without “.wordpress.com”). 

 

Key Trends in the Creative Economy 

• Short-form video dominance 

• AI-powered creativity 

• Personal branding 

• Community building 

• Local content with global reach 

 

Digital Tools & AI in Content Creation 

Digital Content Creation Overview 

Digital content creation involves producing and sharing information or stories in formats like text, 

images, videos, or graphics. 

Common Content Types 

• Social media posts 

• Short videos and vlogs 

• Infographics 

• Podcasts 

• Blog articles or newsletters 

 

Essential Tools for Creators 

Category Purpose Tools 
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Writing Brainstorming & scripting Large language models (LLMs), Notion, Grammarly 

Design Posters, logos, thumbnails Canva, Adobe Express, Leonardo AI 

Video Editing Cut & enhance footage CapCut, VN Editor, Adobe Premiere Rush 

Audio Sound editing Audacity, BandLab 

Scheduling Post management Meta Suite, Buffer, Hootsuite 

Table 2: Essential tools for creators 

Smartphones as Production Studios 

• Clean camera lens before filming 

• Use natural light and stable tripod 

• Record horizontally (YouTube) or vertically (Reels/TikTok) 

• Capture clear audio with earphones or mic 

AI in Content Creation 

Function What It Does Example Tools 

Idea Generation Suggests content ideas Large language models (LLMs), Copy.ai 

Script Writing Drafts scripts Jasper, Sudowrite 

Graphic Design Creates visuals Canva AI, DALL·E 

Video Editing Automates tasks Runway ML, Pika Labs 

Table 3: AI in content creation 

Steps in the Content Creation Process 

1. Plan 

2. Script 

3. Design or Record 

4. Edit 

5. Publish 

 

Stages of film and video production 
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Film and video production happens in three major phases: 

1. Pre-Production – planning and preparation 

2. Production – shooting/recording 

3. Post-Production – editing and finishing 

Each phase is crucial and builds upon the other. 

 

Pre-production (Planning & Preparation Stage) 

Pre-production is the stage where all the planning and groundwork for the project happens before the 

cameras start rolling. It’s about turning an idea into an actionable plan, organizing people, locations, 

equipment, and finances. 

Key Objectives 

• Develop the story or concept 

• Prepare all logistics (budget, schedule, cast, crew, gear) 

• Ensure the production runs smoothly and within budget 

 

Key Steps in Pre-production 

1. Concept Development 

• Brainstorm and refine your idea. 

• Define the purpose (entertainment, education, ministry, marketing, etc.). 

• Identify your target audience. 

• Write a clear logline and synopsis. 

Example: 

“A young woman learns to forgive through a divine encounter after a betrayal.” 

2. Scriptwriting 
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• Write or refine your script with clear scenes, dialogue, and actions. 

• Review for story flow, emotional tone, and pacing. 

• Make sure the story fits the desired duration. 

• Include stage or camera directions if needed. 

Use ChatGPT to draft, format, or refine scripts. 

3. Storyboarding and Shot Planning 

• Create visual sketches or descriptions of each scene. 

• Plan camera angles, movements, and transitions. 

• Decide on visual style (color tone, lighting mood). 

• Tools: Canva, Boords, Storyboard That. 

4. Budgeting 

• Estimate all production costs: 

✓ Equipment (cameras, lights, microphones) 

✓ Cast and crew payment (if applicable) 

✓ Transport and accommodation 

✓ Location fees 

✓ Post-production and distribution 

• Always add a contingency (10–15%) for unexpected expenses. 

5. Scheduling 

• Create a production schedule (shooting days, setup times, deadlines). 

• Consider actors’ availability, weather, and location access. 

• Use scheduling tools or spreadsheets. 

6. Casting 

• Choose actors who fit each role naturally. 

• Hold auditions or select from known talent. 

• Share the script early so they can prepare. 

Look for expressive and reliable individuals rather than just looks. 

7. Location Scouting 
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• Visit and evaluate potential filming sites. 

• Check lighting conditions, noise levels, and permissions. 

• Take photos or videos for reference. 

• Secure necessary permits or permissions. 

8. Crew and Equipment 

• Identify your crew (director, camera operator, sound engineer, lighting tech, editor, etc.). 

• List all equipment needed: cameras, tripods, lights, mics, batteries, memory cards. 

• Test everything before shoot day. 

9. Rehearsals 

• Conduct script readings and practice key scenes. 

• Block actor movements (where they stand, walk, look). 

• Test timing and emotional delivery. 

10. Production Plan / Call Sheet 

• A document detailing: 

✓ Shooting schedule 

✓ Crew contacts 

✓ Locations 

✓ Equipment checklist 

✓ Emergency info 

• Share with everyone involved. 

 

Outcome of Pre-production 

• Complete script and storyboard 

• Budget and schedule 

• Cast and crew confirmed 

• Locations booked 

• Equipment ready 

• Everyone knows their roles and timelines 

Production (The Shooting Stage) 
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This is the execution phase where all footage, sound, and performances are captured based on the pre-

production plan. It’s the most intensive and time-sensitive phase. 

 

Key Objectives 

• Capture high-quality visuals and audio 

• Ensure performances align with the script and director’s vision 

• Keep production on schedule and within budget 

Key Activities in Production 

1. Setup and Preparation 

• Arrive early to set up equipment. 

• Check camera batteries, lights, microphones, and props. 

• Review the day’s call sheet with crew. 

• Do quick rehearsals before shooting. 

2. Lighting and Sound 

• Ensure lighting is consistent and matches the intended mood. 

• Use reflectors or diffusers to control brightness and shadows. 

• Record clean audio : minimize background noise. 

• Always monitor sound through headphones. 

3. Camera Work 

• Frame shots carefully (rule of thirds, headroom, etc.). 

• Capture a mix of shots: 

✓ Wide shots – establish the scene 

✓ Medium shots – dialogue and action 

✓ Close-ups – emotions and detail 

• Use a tripod for stability unless handheld is intentional. 

• Record extra takes for safety. 

4. Directing 

• Guide actors on tone, movement, and emotion. 
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• Communicate clearly with crew. 

• Maintain a calm, organized atmosphere. 

• Be open to creative ideas, but stick to schedule. 

Keep reviewing your storyboard and shot list. 

5. Continuity 

• Keep details consistent between takes (props, costume, lighting, etc.). 

• Assign someone to track continuity (the script supervisor). 

6. Monitoring Quality 

• Review each scene after shooting (“playback”) to confirm sound and visuals are okay. 

• Backup footage immediately (on hard drives or cloud). 

7. Safety and Etiquette 

• Follow safety procedures on set. 

• Respect property and locations. 

• Ensure hydration and breaks for the team. 

 

Outcome of Production 

• All planned scenes are filmed 

• Quality audio and visuals recorded 

• Backup of all footage and sound files 

• Production logs updated 

 

Post-production (Editing & Finalization Stage) 

Post-production is where all the raw materials, video, sound, music, and effects, are combined to create 

the final film or video. This is where the story truly comes alive. 
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Key Objectives 

• Assemble, refine, and polish the footage 

• Add visuals, audio, and graphics for impact 

• Prepare the final product for distribution 

 

Key Steps in Post-production 

1. Ingesting and Organizing Footage 

• Import all video and audio files into editing software. 

• Label clips by scene and take (e.g., “Scene1_Take3”). 

• Backup everything before editing. 

2. Rough Cut (Initial Edit) 

• Arrange the clips in order following the script. 

• Focus on story flow rather than perfection. 

• Remove unusable footage and select best takes. 

3. Fine Cut (Detailed Edit) 

• Refine transitions, pacing, and timing. 

• Trim unnecessary pauses. 

• Add cutaways, reaction shots, or inserts for visual interest. 

• Ensure emotional rhythm matches the story. 

4. Sound Editing 

• Clean background noise. 

• Add or adjust dialogue, voiceovers, and effects. 

• Balance volume levels between clips. 

5. Music and Sound Design 

• Add background music to enhance emotion. 

• Use sound effects for realism (door creaks, footsteps, wind, etc.). 

• Ensure proper licensing for music if publishing publicly. 
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6. Color Correction and Grading 

• Adjust brightness, contrast, and color consistency. 

• Apply color tones to create mood (e.g., warm for hope, cool for sadness). 

7. Visual Effects (Optional) 

• Add text overlays, transitions, animations, or motion graphics. 

• Include your title sequence, credits, and logos. 

8. Review and Feedback 

• Watch the film multiple times with fresh eyes or test audiences. 

• Note any errors in pacing, sound, or continuity. 

• Make final corrections. 

9. Export and Distribution 

• Export in suitable formats (MP4, MOV, etc.). 

• Prepare different versions for social media, TV, or cinema. 

• Add subtitles if necessary. 

• Upload, screen, or archive the final project. 

 

Outcome of Post-production 

• Polished final video 

• Proper sound mix and color grade  

• Titles, subtitles, and credits 

• Exported files ready for sharing or screening 

 

Tips for Success 

• Spend more time in pre-production : good planning saves time and money. 

• Always shoot extra footage (B-roll) for flexibility in editing. 

• Keep your project organized : label everything properly. 

• Ensure you have backup copies of all media. 
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• Get feedback before finalizing. 

• Focus on storytelling and emotion, not just visuals. 

 

Storyboarding 

What is a storyboard? 

A storyboard is a visual plan of a video, film, animation, commercial, or interactive sequence. It breaks 

the script into ordered frames (like a comic strip) showing key shots, camera moves, action, dialogue 

keypoints, and timing. 

Purpose: communicates creative intent, camera coverage, and pacing so the whole team (director, camera, 

editor, animators) can work from the same plan. 

 

When to use a storyboard 

• Pre-production for film, video, animation, motion graphics. 

• Planning explainer videos, training clips, ads, or UI/UX flows. 

• Blocking scenes with actors, staging VFX, or timing complex sequences. 

• Pitching an idea to clients or stakeholders. 

 

Basic components of a storyboard frame 

Each frame usually contains: 

• Frame drawing (simple sketch of composition) 

• Shot number (1, 2, 3…) 

• Description / Action (what happens in the shot) 

• Dialogue / Sound (lines, SFX, music cues) 

• Camera (type of shot : e.g., CU, MS, LS; camera moves : pan, tilt, dolly) 

• Duration / Timing (approx seconds or beats) 

• Notes (lighting, props, actor directions, VFX) 
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Common shot abbreviations (quick reference) 

• ECU : Extreme Close Up 

• CU : Close Up 

• MS : Medium Shot 

• MLS : Medium Long Shot 

• LS / Wide : Long Shot / Wide Shot 

• OTS : Over The Shoulder 

• POV : Point Of View 

• INT / EXT : Interior / Exterior 

• VO : Voice Over 

Camera moves: PAN, TILT, DOLLY, ZOOM, TRACK, CRANE, HANDHELD, STEADICAM. 

 

Step-by-step: How to develop a storyboard 

1. Read the script & define the story beats: Identify scenes, moments of action, emotional beats, and 

any necessary camera coverage. 

2. Create a shot list (high level): For each beat list the shots you might need (e.g., Establishing LS 

→ Two shot → CU reaction → Cutaway). 

3. Decide pacing & timing: Estimate durations (e.g., Establishing 4s, Dialogue exchange 2–3s per 

shot). 

4. Choose a template / layout: Typical grid: 3–6 frames per page with space for notes beneath each 

frame. 

5. Sketch frames : rough is fine: Focus on composition, actor blocking, camera angle/move : not art 

quality. Use arrows to show movement. 

6. Add annotations: Dialogue lines, SFX, camera instructions, props, continuity notes. 

7. Sequence & review: Flip through frames to check rhythm and clarity. Can you follow action 

without the script? 

8. Refine: Merge or split shots as needed, adjust timing. 

9. Share with the team: Get feedback from director, cinematographer, editor, production designer. 

10. Finalize for production: Produce a clean version for the shoot (numbered frames, shot IDs, and 

callouts for equipment and props). 

 

Different ways to storyboard (methods) 
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• Paper & pencil (classic): fast, tactile, great for ideation and collaboration on a table/whiteboard. 

• Index cards / Post-its: one beat per card; easy to reorder and group. Excellent for blocking story 

flow. 

• Digital drawing (vector/raster): more polished frames; useful for presentation. 

• Animatic: turn storyboard images into a timed video with rough cuts, temp audio, and basic 

motion to test pacing. 

• Thumbnail storyboards: tiny sketches focused on composition and beats (usually used early). 

• Panel/script hybrid: combine script text on one side and frame/sketch on the other. 

• Shot list first, storyboard later: create detailed shot list and only storyboard complicated or 

expensive shots. 

• Digital collages / photo board: use photos, screenshots, or reference images arranged into 

storyboard frames (good for mood/lighting reference). 

 

AI-free tools you can use (practical & mostly free) 

These are tools that do not require AI features : ideal for producing storyboards without relying on AI 

generators. 

Analog / Offline 

• Plain paper + pencil/marker (fastest). 

• Index cards / Post-its and a wall. 

• Whiteboard + dry-erase markers. 

Desktop / Office 

• Microsoft PowerPoint or Google Slides : create slide per shot with image + notes. (Easy to 

reorder and present.) 

• LibreOffice Impress : free alternative to PowerPoint. 

• GIMP (free raster editor) : for drawing or collaging frames. 

• Krita (free digital painting) : if you want to draw frames digitally. 

Dedicated storyboard software (free / open source / inexpensive) 

• Storyboarder (Wonder Unit) : open-source storyboard app (simple drawing tools, export options, 

animatic support). 

• Celtx : has storyboard and preproduction features (free/paid tiers; useful for script ↔ storyboard 

workflow). 
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• Trello (or any Kanban board) : use cards for shots (not a drawing tool but great for organization). 

Simple image editing / collage 

• Canva (free tier) : use grids to create storyboard panels and add text notes. 

• Google Drawings : quick collages with text annotation. 

For animatics / rough timing 

• iMovie (macOS/iOS) or Windows Video Editor : import storyboard images, add audio, set 

durations. 

• OpenShot or Shotcut : free video editors to make animatics. 

 

Turning a storyboard into an animatic (why & how) 

Why: animatics help verify timing, pacing, sound sync, and identify missing coverage or awkward cuts 

before shooting. 

How: export storyboard frames as images → import into a video editor in sequence → add temp 

dialogue/music/SFX → set durations → play back and tweak. 

 

Tips for effective storyboards 

• Keep sketches simple : clarity > artistry. Use stick figures if needed. 

• Use arrows to indicate motion (actor or camera). 

• Label shots clearly (scene:shot, e.g. 2A, 2B). 

• Show camera perspective (high/low/eye level) to communicate mood. 

• Prioritize coverage : ensure you have master shots, coverage for dialogue, and cutaways for 

reactions. 

• Think edit : shoot with the edit in mind (matching action, eyelines, 180° rule). 

• Mark continuity (time of day, prop positions, clothing) to prevent mistakes. 

• Annotate VFX or green screen areas clearly. 

• Make a shot list from the storyboard to pass to camera/production team. 

 

Common mistakes to avoid 
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• Over-storyboarding every trivial shot : wastes time. 

• Being so detailed that the board becomes inflexible; allow room for creative change. 

• Ignoring practical production constraints (budget, available locations, equipment). 

• Sketches that are unclear to others; always label and annotate. 

• Forgetting sound: VO, SFX, or music cues are essential for timing. 

 

 

 

 

 

 

 

 

 

 

Example simple storyboard template (one frame) 
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Accessibility & handover 

• Provide text descriptions of visual frames for team members with visual impairments. 

• Keep a versioned file system (v1, v2) and a clear change log so production can track updates. 

• Export PDF or images for on-set printouts. 

 

Evaluation / checklist before production 

• Are the story’s beats clearly represented? 

• Does each scene have enough coverage? (master, medium, close, cutaways) 

• Is timing tested with an animatic? 

• Are camera moves feasible with available kit? 

• Are VFX / SFX clearly called out? 

• Is the storyboard labeled and organized for the crew? 
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A storyboard is a simple visual roadmap that translates script into camera shots, timing, and direction : 

build it in stages (script → shot list → sketches → animatic), use simple tools (paper, Storyboarder, 

PowerPoint), focus on clarity, and always test timing with an animatic before production. 

 

How to create a storyboard in Canva 

A practical, beginner-friendly walkthrough to build a clear, usable storyboard in Canva (web or mobile). 

Includes layout suggestions, timing/animatic tips, collaboration, and export options. 

You’ll build a storyboard by creating a multi-panel layout (each panel = one shot), adding sketches or 

images, annotating action/camera/sound, and exporting as images, PDF, or a timed animatic video. 

 

Step-by-step 

1. Sign in to Canva 

1. Open canva.com or the Canva mobile app. 

2. Sign in (or create a free account). 

2. Start a new design 

• Click Create a design → Custom size. Recommended: A4 (210 × 297 mm) or US Letter 

(8.5 × 11 in) for printable storyboards. For widescreen presentation: 1920 × 1080 px (if 

you want an on-screen animatic). 

• Click Create design. 

3. Pick or create a storyboard template 

• In the left panel, search “storyboard” : choose a ready template and click it, OR: 

• Create your own grid: Go Elements → Grids and pick a 2×3, 3×3, or custom grid to 

define panels per page. Add multiple pages (one page per scene or sequence). 

4. Set up a reusable frame layout (recommended) 

• On page 1 build a panel template: each grid cell becomes a frame. 
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• Below or beside each frame add text boxes for: Shot #, Duration, Action, Camera, 

Dialogue/Audio, Notes. 

• Use consistent fonts/sizes (e.g., header 14–16pt, notes 10–12pt). 

• Lock these elements (click an element → More → Lock) so you can duplicate the page without 

changing the template. 

5. Add your visuals 

You have options depending on skill/time: 

• Sketches: Upload photographed hand sketches (Upload → Upload media) and drop into frames. 

• Photos / Stills: Use Canva’s Photos library as reference images or mood frames. 

• Shapes & Icons: Use simple shapes and stick figures from Elements to block composition 

quickly. 

• Screenshots / Frame grabs: Drag existing images into panels for a photo-board style. 

Tip: Use arrows (Elements → lines/arrows) to show camera or actor movement. 

6. Fill in shot details 

Under each panel, add your metadata: 

• Shot #: e.g., 2A 

• Type: (LS, MS, CU…) 

• Duration: e.g., 3s 

• Action: short sentence describing what happens 

• Dialogue / SFX / Music: short cue 

• Camera: pan left / dolly in / handheld 

Keep each field concise:this is a production tool, not a script. 

7. Duplicate pages and build your sequence 

1. Right-click the page thumbnail → Duplicate page to keep the same layout. 

2. Progressively replace images/sketches and update text for each shot. 

3. Reorder pages by dragging thumbnails to arrange scenes. 

8. Add timing / create an animatic (optional) 

To preview pacing: 
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1. Convert storyboard pages into a simple video: in Canva click Download → MP4 video (when 

you have multi-page images). 

2. Or, in Editor, use Animate on images or set page duration: click the page number → Timing 

(Page duration) and set seconds per page. 

3. Add audio (voiceover, temp music) via Uploads → Upload media → drag into the timeline for 

that page (available in Canva Pro and free tier with limited timeline features). 

4. Play the preview to check pacing and adjust durations. 

Note: Canva’s timeline is basic: for more precise animatics, export frames as images and assemble them 

in a video editor (e.g., iMovie, OpenShot). 

9. Collaborate & get feedback 

• Click Share → enter teammates’ emails or get a shareable link. 

• Choose permission: Can view, Can comment, or Can edit. 

• Use Canva’s Comments feature to leave timestamped/element comments. 

10. Export & deliver 

Options depending on purpose: 

• Printable PDF: Download → PDF Print (high quality). 

• Presenter / Pitch Deck: Download → PNG/JPG or present directly in Canva. 

• Animatic / Timed Video: Download → MP4 Video (adjust page durations first). 

• Individual frames: Download selected pages as PNG/JPG for use in editors. 

11. Version control & organization 

• Name your file clearly: ProjectName_storyboard_v01. 

• Keep an export folder with v01, v02 etc., and include a short changelog in the file description or a 

team doc. 

 

Practical layout suggestions 

• 3×2 grid per A4 page: compact, good for printable storyboards. 

• 1 large frame + 3 small frames: good for important master shot + cutaways. 

• One shot per slide (16:9): if you want an animatic-friendly layout. 
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Extra tips & best practices 

• Clarity over artistry: simple sketches are fine if they communicate action/composition. 

• Use arrows to indicate movement; use different arrow styles for camera vs actor. 

• Keep notes short: production reads quickly on set. 

• Include scale cues (actor positions, prop placement) for continuity. 

• Test pacing with an animatic early: you’ll catch timing issues before shoot day. 

• Use templates: create a reusable Canva template for all projects to save time. 

• Mobile app: you can sketch on paper, snap photos, upload from your phone, and edit on the 

Canva mobile app:great for on-the-go storyboarding. 

 

Quick checklist before you finalize 

• Shots numbered and sequenced correctly 

• Each panel has action + camera + duration + audio cue 

• Movement indicated (arrows) and eyelines consistent 

• Exported in the correct format (PDF for print, MP4 for animatic) 

• Shared with team and feedback incorporated 

 

Scriptwriting 

What is scriptwriting? 

Scriptwriting (or screenwriting/playwriting) is the craft of writing the blueprint for a performance: film, 

TV, web video, theatre, radio, or podcast. A script describes action, dialogue, character, setting, and 

structure so directors, actors, and crew can create the finished piece. Good scripts show story and emotion 

visually and audibly rather than explaining them. 

 

Core elements of any script 

• Story/Concept: the central idea or hook. 

• Characters: who drives the story and what they want (their objective). 
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• Structure: the sequence of events (acts, scenes, beats). 

• Dialogue: what characters say: must reveal character or move plot. 

• Action / Stage Directions: what’s seen on screen/stage? 

• Theme: the underlying message or question. 

• Format: the technical layout (sluglines, action, dialogue) so industry readers can navigate easily. 

 

Major script formats (quick) 

• Screenplay (film/TV): industry standard format:sluglines (INT./EXT.), action lines, character 

names centered, dialogue under names, parentheticals, transitions. 

• Teleplay (TV): similar to screenplay, with act breaks and (for multi-cam) different formatting. 

• Stage play: acts and scenes, character names in margin with dialogue; stage directions in italics or 

brackets. 

• Radio/Podcast script: emphasis on sound cues, SFX, and voice. 

• Video/Corporate/Web script: shot descriptions and timing often included (more practical, less 

literary). 

 

Step-by-step guide on how to develop a script 

Step 1 : Idea & logline 

• Distill your idea into one sentence (logline). It should state protagonist, goal, antagonist/conflict, 

and stakes. 

Step 2 : Premise & high-level outline 

• Expand to a short paragraph describing beginning, middle, end. 

• Identify the inciting incident (what sets story in motion). 

Step 3 : Characters & arc sheets 

• Create character sheets for protagonist, antagonist, and major supporting characters: goal, 

motivation, flaw, arc (how they change). 

Step 4 : Structure & beat sheet 
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• Decide structure (3-act, 4-act, episodic). 

• Write a beat sheet: list major story beats in order (e.g., Opening Image → Set-up → Catalyst → 

Debate → Midpoint → Crisis → Climax → Resolution). 

Step 5 : Scene list / shot list (planning) 

• Break beats into scenes. For film/TV include rough locations, purpose of scene, and which 

characters are present. 

Step 6 : First draft (write quickly) 

• Write a full draft without obsessing over polish. Use industry format if you aim to submit. Focus 

on story and character choices. 

Step 7 : Rewrite rounds 

• Read aloud, trim fat, check pacing, deepen character choices. Rewrites typically focus separately 

on structure, character, and dialogue. 

Step 8 : Feedback & table reads 

• Get notes from trusted readers and do table reads if possible (actors reading the script helps reveal 

problems). 

Step 9 : Polish & proofread 

• Tighten dialogue, fix formatting, correct typos, and ensure transitions/acts are clear. Finalize 

length (page count ≈ minutes for film: ~1 page ≈ 1 minute). 

Step 10 : Formatting & presentation 

• Ensure your script follows the accepted format for your medium. Add a title page, contact info, 

and a short logline on a separate sheet if submitting. 

 

 

Different approaches to writing scripts 
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• Outline-first: Full outline/beat sheet then write scene by scene. 

• Discovery writing (pantsing): Start writing and discover the story as you go; revise structure later. 

• Collaboration: Co-writing with a partner (divide acts/scenes, workshop together). 

• Adaptation: Turn existing work (book, article) into a script: requires structure and cutting. 

• Writing to format: For videos or ads, write directly to timing and shot constraints. 

AI-free tools for scriptwriting (free & low-cost) 

These tools do not require AI and are suitable for writers who prefer manual craft: 

Simple text / cloud editors 

• Google Docs: collaborative, easy templates (use screenplay add-ons or manual style). 

• LibreOffice / OpenOffice: offline writing, free. 

Desktop/open-source screenplay tools 

• Trelby: free, open-source screenplay editor (Windows/Linux). 

• Kit Scenarist: free/open-source (planning and writing tools). 

• Fade In: paid but has a robust demo; industry-quality (not AI). 

• WriterDuet: collaborative; has a free tier (non-AI). 

• Celtx: free/basic storyboard and script tools (paid plans for production features). 

Plain-text markup options 

• Fountain: plain-text screenplay format (works with many editors; lets you write in any text editor 

and import into screenplay apps). 

Production / planning 

• Trello or Notion: for scene/beat boards and production tracking. 

• Google Sheets: write beat sheets, shot lists, and production schedules. 

 

 

 

Story craft tips (writing that works on screen) 
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• Show, don’t tell: prefer visual actions over exposition. 

• Characters want something: clear objectives create conflict. 

• Make scenes do work: each scene should advance plot or reveal character. 

• Economy of dialogue: subtext is powerful; people rarely say exactly what they mean. 

• Obstacles & stakes: constantly raise stakes and introduce obstacles. 

• Callbacks & parallels: use recurring motifs, lines, or images for emotional payoff. 

• Conflict > conversation: scenes with internal or external conflict engage viewers. 

 

Common mistakes to avoid 

• Overlong exposition at the top of the script. 

• Characters who do the same thing: make them distinct. 

• Unclear protagonist or weak stakes. 

• Overly “directorial” descriptions: leave room for collaborators. 

• Ignoring format conventions (industry readers expect a standard layout). 

• Not testing dialogue aloud: it may sound unnatural on page. 

 

How to get feedback & improve 

• Do table reads with actors or friends. Hearing script aloud reveals problems fast. 

• Join local or online writers’ groups for notes. 

• Read produced scripts in your genre to learn rhythm and formatting. 

• Rework: accept that scripts are rewritten many times: every draft teaches you something. 

 

Preparing your script for submission or production 

• Keep it clean: correct spelling, consistent margins, and industry spacing. 

• Title page with contact info (or use a manager/agent contact). 

• Include a short logline at the top of query emails. 

• Know the page-to-runtime ratio: ~1 page per minute for film (varies by dialogue). 

• Make a one-page synopsis and a two-page treatment ready for producers. 

How to Use Notion for Scriptwriting 
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What is Notion and why use it for scriptwriting? 

Notion is a powerful, all-in-one workspace where you can write, organize, plan, and collaborate. 

For scriptwriters, it’s a great tool for: 

• Organizing story ideas, characters, and scenes 

• Structuring scripts before exporting to a screenplay app 

• Tracking revisions, deadlines, and production notes 

• Collaborating with co-writers or producers online 

It’s free for personal use, easy to customize, and can be used on desktop or mobile. 

 

Setting up your Notion workspace for scriptwriting 

Step 1: Create a new page 

1. Open notion.so and log in (or create a free account). 

2. Click “+ New Page.” 

3. Give it a title (e.g., My Screenplay Project). 

4. Choose a simple blank page or table database layout. 

How to organize your scriptwriting workflow in Notion 

Step 2: Add key sections (pages or toggles) 

Create subpages or toggles under your main page for: 

• Idea Bank / Concepts: rough story ideas, themes, and inspirations. 

• Loglines & Premises: one-line pitches for each concept. 

• Character Profiles: name, age, goal, motivation, flaw, backstory. 

• Story Structure / Beat Sheet: organize the story acts and turning points. 

• Scene List: breakdown of all scenes with locations and characters. 

• Script Drafts: actual script text (or links to screenplay documents). 

• Research & References: articles, images, or videos for tone and setting. 

• Feedback & Notes: comments, suggestions, or rewrite plans. 

https://www.notion.so/
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Using Notion’s built-in tools effectively 

Feature Use for Scriptwriting 

Headings (H1–H3) Organize sections clearly (e.g., Act I, Act II). 

Toggle Lists Hide long paragraphs (useful for drafts or notes). 

Tables / Databases Track characters, scenes, or props systematically. 

Kanban Boards Visualize story progress (To Write / In Progress / Done). 

Templates Save your page layout for future projects. 

Comments & Sharing Get co-writer or mentor feedback in real time. 

Table 4: Using Notion’s built-in tools effectively 

Step-by-step: Creating a script outline in Notion 

1. Create a new page titled “Script Outline.” 

2. Use Heading 1: Act I – Setup 

✓ Under it, use bullets or toggles for: Opening Image, Theme Stated, Catalyst. 

3. Add Heading 2: Act II – Confrontation 

✓ Include beats like Midpoint, Bad Guys Close In, Crisis. 

4. Add Heading 3: Act III – Resolution 

✓ Include Climax, Final Image. 

5. Under each heading, briefly describe the action or purpose of that beat. 

6. Link related character pages or scene notes by typing @CharacterName. 

 

Writing your script inside Notion 

Although Notion isn’t a professional screenwriting formatter, you can still draft early versions: 

• Use bold text for sluglines (e.g., INT. OFFICE - DAY) 

• Italicize action and center dialogue manually using indentation 

You can later export to a screenplay format using tools like Celtx, Trelby, or Fade In. 
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Using Notion databases for characters and scenes 

Character Database 

Name Role Goal Conflict Arc Notes 

Terry Protagonist Find freedom Fear of failure Learns courage Single mother, writer 

Otieno Antagonist Control Sarah Pride Falls from power Business partner 

Table 5: Character Database 

Scene Database 

Scene # Location Description Characters Status 

1 Kitchen Terry receives a call Sarah Draft 

2 Office Otieno proposes a deal Sarah, Daniel To Write 

Table 6: Scene Database 

This lets you filter or sort by location, act, or completion status, perfect for planning rewrites. 

Collaboration in Notion 

• Invite collaborators via “Share” → “Invite.” 

• Use comments to discuss lines or beats. 

• Assign tasks (e.g., Revise Act I, Add dialogue to Scene 4). 

• Keep all notes centralized, no endless email threads. 

 

Integrating Notion with other tools 

You can link or embed: 

• Google Docs / Celtx / Trelby scripts for final writing. 

• YouTube / Pinterest references for mood boards. 

• Calendars or production schedules for deadlines. 

• AI tools (optional) like ChatGPT for idea brainstorming or rewriting prompts. 
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Use Notion’s “/embed” or “/link” command to connect these easily. 

 

Optional AI-free templates to start with 

You can create your own or duplicate existing templates like: 

• Screenplay Planner Template 

• Story Beat Sheet Template 

• Character Development Database 

• Scene Tracker Table 

You can find free Notion templates for scriptwriting at: 

• Notion Template Gallery 

• Reddit: r/NotionTemplates 

 

Final workflow example (recommended order) 

1. Idea Dump → rough notes 

2. Logline Page → refine the story 

3. Character Database → define arcs 

4. Beat Sheet Page → outline acts 

5. Scene Database → detail each scene 

6. Script Page → write rough draft 

7. Feedback Page → collect notes 

8. Export → finalize in professional script editor 

 

Tips for success 

• Keep your Notion dashboard simple : too many pages = confusion 

•  Use emojis or icons to identify sections visually (🎬 Script,     Ideas, 👥 Characters). 

• Regularly back up or export your workspace. 

• Write first, format later: Notion is for story development, not final formatting. 

https://www.notion.so/templates
https://www.reddit.com/r/NotionTemplates/
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• Duplicate templates for new projects: saves time. 

 

Optional extension ideas 

• Add a “Production Tracker” to monitor progress once your script goes to filming. 

• Use Notion Calendar for writing schedule & deadlines. 

• Connect to Google Drive or Dropbox for backups. 

Notion is not a screenplay software but an excellent organizing and outlining platform for writers. It helps 

you brainstorm, plan, track, and collaborate effectively: making your actual scriptwriting faster, clearer, 

and more enjoyable. 

 

How to Scriptwrite Using ChatGPT 

ChatGPT is an AI writing assistant that helps you brainstorm, structure, and polish your scripts faster : 

from idea generation to dialogue refinement. It’s not a replacement for your creativity, but a creative 

collaborator that can help you: 

• Generate story ideas or prompts 

• Outline story structure and beats 

• Draft and format screenplay text 

• Edit dialogue and action descriptions 

• Overcome writer’s block and speed up revisions 

 

Before you start: What you should prepare 

Before you ask ChatGPT to help you write, be clear about: 

• Your goal: (film, short video, church skit, training video, ad, etc.) 

• Target audience: (students, adults, church members, children, etc.) 

• Desired tone: (inspirational, dramatic, educational, humorous, etc.) 

• Script length: (1 min, 5 min, full-length, etc.) 

• Main message or theme : what you want people to feel or learn 
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• Format preference: (screenplay format, stage play, voice-over script, etc.) 

You can type this information in a short paragraph before you start prompting. 

 

Step-by-step guide: Writing a script using ChatGPT 

Step 1: Generate or refine your idea 

Prompt example: 

“I want to write a 3-minute inspirational short film about forgiveness set in a small church. Help me 

brainstorm 5 different story ideas.” 

ChatGPT will give you several options: pick one or mix a few. You can ask for twists or emotional 

endings. 

Step 2: Develop your logline 

Once you pick an idea, create a logline (a one-sentence summary). 

Prompt example: 

“Help me write a logline for a short film about a woman who learns to forgive her friend after a 

misunderstanding in church.” 

Then refine it: 

“Make the logline more emotional and cinematic.” 

Step 3: Create a beat sheet or story outline 

Prompt example: 

“Create a 3-act story outline for my short film titled Grace Restored. Keep it under 5 minutes long.” 

You’ll get something like: 



  
  

INNOVATE – EMPOWER - TRANSFORM 
  

72 | P a g e  

 

• Act 1 (Setup): Introduce Sarah and her conflict 

• Act 2 (Confrontation): Flashbacks, emotional struggle 

• Act 3 (Resolution): Forgiveness and healing moment 

You can ask: 

“Add more tension in Act 2,” or “Include a symbolic moment using light.” 

Step 4: Develop character profiles 

Prompt example: 

“Create character bios for my main characters: Sarah (protagonist), Ruth (friend), and Pastor John 

(mentor). Include age, personality, goal, and flaw.” 

This helps the AI write consistent dialogue later. 

Step 5: Start the first draft 

Prompt example: 

“Write Scene 1 of my short film Grace Restored. Format it like a film script. Show Sarah alone in church, 

wrestling with guilt. Add realistic dialogue and visual description.” 

ChatGPT will generate a screenplay-style scene. You can refine by saying: 

“Add more emotion,” or “Make the dialogue shorter and more natural.” 

Always review and rewrite. Let ChatGPT give multiple variations until the tone feels right. 

Step 6: Continue scene by scene 

Instead of writing the whole script in one go, proceed scene by scene: 

• It keeps the tone consistent. 

• You can control pacing and flow. 

• Easier to edit and give focused feedback. 

Prompt example: 
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“Write Scene 2: Sarah visits Ruth’s house to confront her, but can’t bring herself to speak. Add subtext 

and tension.” 

Step 7: Format the script properly 

Ask ChatGPT to use screenplay formatting: 

Prompt example: 

“Format my script as a professional screenplay with scene headings, action, and centered dialogue.” 

Or you can paste your rough text and say: 

“Format this like a film script with correct spacing and style.” 

Step 8: Add emotion and visual depth 

Prompt example: 

“Rewrite Scene 3 to make it more cinematic. Use sensory details: what we see, hear, and feel.” 

“Add camera direction hints subtly.” 

This turns plain writing into a visual experience. 

Step 9: Edit and polish 

Use ChatGPT as your editing partner. 

Prompt examples: 

• “Check my script for pacing and flow.” 

• “Shorten dialogue but keep meaning.” 

• “Make the tone more hopeful.” 

• “Make this character sound older/wiser/younger.” 

You can also ask it to: 

“Identify weak dialogue lines and suggest improvements.” 

Step 10: Generate titles, loglines, and summaries 
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After finishing your draft: 

Prompt examples: 

• “Suggest 5 possible titles for this short film.” 

• “Write a one-paragraph synopsis for a festival submission.” 

• “Create a 30-second trailer script from my screenplay.” 

 

Using ChatGPT for different script types 

Script Type Special Prompt Example 

Short Film “Write a 5-minute emotional short film about kindness with 3 characters.” 

Church Skit “Create a short drama script about faith and forgiveness for youth group 

performance.” 

YouTube 

Video 

“Write a 2-minute educational video script with narrator voice and cutaway visuals.” 

Training Video “Write a corporate training script explaining teamwork, with narrator and scene 

examples.” 

Podcast / 

Radio 

“Write a dialogue-based audio script for a 10-minute storytelling podcast.” 

Table 7: Using ChatGPT for different script types 

Things to consider when using ChatGPT for scriptwriting 

Do’s 

• Be specific in your prompts (tone, length, audience). 

• Always review and rewrite : treat AI output as a first draft. 

• Use follow-up prompts like “make it more emotional” or “add humor.” 

• Keep a consistent story bible (characters, settings, tone). 

• Use ChatGPT to brainstorm, not to replace your voice. 

Don’ts 

• Don’t expect perfect formatting: polish it in a proper script editor. 
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• Don’t copy others’ ideas without checking originality. 

• Don’t rely solely on AI for emotional authenticity: add your own experience. 

• Don’t skip the revision stage: always re-read aloud. 

 

Tools to pair with ChatGPT 

Purpose Recommended Tool Use 

Formatting Trelby, Celtx, WriterDuet Proper screenplay layout 

Storyboards Canva, Storyboard That, Boords Visualize scenes 

Notes & Structure Notion, Google Docs, Milanote Organize beats and characters 

Voice/Scene Testing ElevenLabs, TTSMaker Hear your dialogue read aloud 

Image generation DALL·E, Leonardo AI, Firefly Create visuals for scenes 

Refining your workflow (for serious writers) 

Ideal process: 

1. Outline story in Notion or Docs 

2. Draft each scene using ChatGPT 

3. Copy script into Trelby/Celtx for formatting 

4. Read aloud, revise dialogue 

5. Use AI again for polishing and trimming 

6. Export to PDF and test timing (1 page ≈ 1 minute of screen time) 

 

Example full workflow prompt (ready to use) 

“You are a professional screenwriter. Help me write a short film script titled Second Chance. 

It’s a 5-minute inspirational story about forgiveness between two friends in a church setting. 

Target audience: young adults. 

Tone: emotional, realistic, hopeful. 

Format: professional screenplay with scene headings, action, and dialogue. 

Start by giving me a 3-act outline before we write Scene 1.” 
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Then continue scene-by-scene with follow-up prompts like: 

“Now write Scene 1 based on the outline.” 

“Now continue with Scene 2.” 

“Add a powerful ending with symbolism and minimal dialogue.” 

 

Common mistakes when using ChatGPT for scriptwriting 

• Writing too generally (you must feed it details). 

• Forgetting to define tone or genre. 

• Letting AI over-describe instead of showing action. 

• Ignoring pacing (scripts can become wordy). 

• Not personalizing the story: your human touch makes it real. 

 

Final checklist before exporting your script 

• Strong logline 

• 3-act structure 

• Clear protagonist and goal 

• Realistic dialogue 

• Proper formatting 

• Emotional resolution 

• Polished grammar 

• Readability test (read aloud once) 

Using ChatGPT for scriptwriting is like having a fast, creative co-writer who never gets tired. 

The key is guiding it clearly, reviewing everything critically, and adding your unique human insight. 

Together, you can develop well-structured, emotionally engaging, and production-ready scripts in a 

fraction of the usual time. 
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Location scouting 

Location scouting is the process of finding and evaluating real-world places where scenes in a film, video, 

or photo project will be shot. It involves visiting potential sites, assessing their suitability for storytelling, 

technical needs, safety, and logistics before production begins. 

 

Purpose of Location Scouting 

• To find visually fitting settings that match the story, mood, and script. 

• To ensure the technical feasibility of shooting (lighting, sound, space, power, etc.). 

• To manage logistics: accessibility, permissions, costs, and safety. 

• To help the crew visualize and plan camera setups, lighting, and blocking. 

 

Why Location Scouting Is Important 

1. Visual consistency: Helps maintain the mood and look described in the script. 

2. Cost efficiency: Prevents expensive mistakes by identifying problems early. 

3. Smooth production: Avoids delays by preparing for location-specific challenges. 

4. Creative inspiration: Sometimes the location itself inspires better storytelling ideas. 

 

When to Do Location Scouting 

• After completing the script and storyboard. 

• Before creating the production schedule or budget. 

• Ideally weeks before shooting to allow time for approvals and adjustments. 

 

Step-by-Step Guide to Location Scouting 

Step 1: Read the Script Carefully 

• Identify all locations mentioned in the script. 
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• Note the type of setting needed for each scene (e.g., classroom, forest, church, market). 

• Determine the time of day (day/night) and mood (happy, tense, spiritual, dramatic). 

• Make a location breakdown sheet listing all scenes and their required settings. 

Step 2: Research Potential Locations 

• Start with online searches, Google Maps, Instagram, film location databases, or local knowledge. 

• Make a list of possible locations that match the script’s description. 

• Consider backup options in case your first choice doesn’t work out. 

You can use ChatGPT or AI tools to suggest ideal filming locations that fit your story’s tone and setting 

(e.g., “Suggest filming locations in Nairobi that look like a 1960s village”). 

Step 3: Visit Locations in Person 

• Physically visit each potential site. 

• Take photos and short videos from different angles and times of day. 

• Check practical factors like: 

✓ Lighting conditions (natural and artificial) 

✓ Background noise (traffic, crowds, wind, animals) 

✓ Space for crew, cameras, and lighting equipment 

✓ Power sources (outlets or generator access) 

✓ Restrooms, parking, and safety 

Visit at the same time of day you plan to shoot to see actual light and noise levels. 

Step 4: Evaluate Suitability 

Ask these questions: 

• Does it match the look and tone of the story? 

• Is it accessible to the team and equipment? 

• Are there any restrictions or hazards? 

• Is there enough room for camera setups and movement? 

• Are permits or fees required? 

Record all answers in a location scouting checklist or app. 

Step 5: Take Reference Photos & Notes 
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• Capture wide shots, mid shots, and close-ups of key areas. 

• Take note of: 

✓ Sun direction (important for lighting) 

✓ Sound environment 

✓ Obstacles or reflective surfaces 

✓ Potential hazards or challenges 

✓ Landmarks for continuity 

• Label photos clearly (e.g., “Scene 5 – Church Interior – Option A”). 

Step 6: Get Permission and Permits 

• Contact property owners, local authorities, or community leaders. 

• Explain your project and shooting schedule. 

• Get written consent or a signed location agreement if required. 

• Discuss: 

✓ Fees or donations 

✓ Liability coverage (insurance if applicable) 

✓ Restrictions (e.g., noise limits, time limits) 

Always maintain professionalism and respect property boundaries. 

Step 7: Plan the Logistics 

• Estimate travel time and transport costs. 

• Identify nearby facilities (toilets, food, parking). 

• Plan crew and equipment movement for each location. 

• Prepare a location layout plan for setup and camera positions. 

Step 8: Prepare a Location Report 

After scouting, prepare a location report to present to your director or team. 

Include: 

• Photos and descriptions 

• Pros and cons of each location 

• Cost estimates 

• Permission status 

• Contact details of property owners 

Use tools like Google Docs, Notion, or Canva for neat presentation. 
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Step 9: Make the Final Decision 

• Compare all scouted options with your team. 

• Choose the location that balances visual appeal, practicality, cost, and safety. 

• Schedule your shoot and confirm all permissions and arrangements. 

Step 10: Prepare for the Shoot Day 

• Revisit the site before shooting day to verify everything is still okay. 

• Reconfirm with the property owner. 

• Prepare signs, safety gear, and backup plans (e.g., alternate shoot days for bad weather). 

 

What to Consider When Choosing a Location 

Category What to Check 

Aesthetic Does it match the story’s setting and mood? 

Lighting Natural light direction and intensity during shoot time 

Sound Noise from wind, traffic, people, or animals 

Space Enough room for cast, crew, gear, and camera movement 

Power Supply Access to electricity for lights, cameras, and monitors 

Accessibility Ease of transport and setup; availability of parking 

Weather Risk of rain, heat, or poor light conditions 

Permissions Legal clearance to film there 

Safety Hazards, terrain, crowds, or unstable structures 

Facilities Toilets, dressing areas, refreshment spots 

Budget Rental or permit fees, travel, accommodation 

Table 8: What to Consider When Choosing a Location 

Tools and AI Resources for Location Scouting 
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Free & Useful Tools 

Tool Use 

Google Maps / Street View Explore potential locations virtually 

ChatGPT Suggest or describe suitable locations for your story 

Pinterest Find visual inspiration for settings 

Notion Organize notes, pictures, and scouting details 

Canva / Google Slides Create visual presentations of locations 

ShotDeck Browse cinematic references from real films 

Trello / Airtable Manage location data, contacts, and permissions 

Sun Surveyor (free app) Check sun angles and lighting conditions 

YouTube / TikTok Watch vlogs or clips filmed in similar areas 

Table 9: Tools and AI Resources for Location Scouting 

AI Prompt Example for Generating a Location Visualization 

“A realistic photo of a film location for a short inspirational movie, quiet church interior with soft 

sunlight through stained glass, cinematic lighting, empty seats, no people, peaceful atmosphere.” 

You can adjust the prompt for your story type: 

• Classroom scene 

• Urban street market 

• Forest meditation setting 

• Office training session 

 

Deliverables After Scouting 

By the end of location scouting, you should have: 

• List of all approved filming locations 
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• Photos and videos of each site  

• Location report or folder 

• Permission letters / agreements 

• Backup location options 

• Notes on logistics and lighting 

Tips 

• Always scout more locations than needed. 

• Take a sound recorder to test noise levels. 

• Bring measuring tape for set design or framing needs. 

• Always respect local communities and environments. 

• Prepare a backup plan for every outdoor location. 

• Keep communication open with property owners and local officials. 

 

How to use a camera (phone or standalone) for content creation 

Understanding Cameras 

Types of Cameras 

1. Smartphone Camera 

✓ Easy to carry and use 

✓ Good for quick, social, or mobile content 

✓ Built-in stabilization and AI filters 

2. Standalone Camera 

✓ Includes DSLRs, Mirrorless, and Camcorders 

✓ Offers manual control, better lenses, and higher quality 

✓ Suitable for professional shoots, YouTube videos, interviews, or films 

 

Basic Camera Parts and Functions 

Part / Setting Function / Description 

Lens Focuses light onto the sensor : determines image sharpness and perspective 
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Sensor Captures light and converts it to an image 

Aperture (f-stop) Controls how much light enters : affects brightness and background blur 

Shutter Speed Determines how long light hits the sensor : affects motion blur 

ISO Adjusts the camera’s light sensitivity : higher ISO = brighter but noisier image 

White Balance Adjusts color temperature (cool vs warm tones) 

Focus Adjusts sharpness on the subject 

Exposure Overall brightness of the image 

Frame Rate (FPS) Frames per second : affects motion smoothness in video (24fps, 30fps, 60fps) 

Resolution Number of pixels (1080p, 4K) : higher = sharper image 

Table 10: Basic Camera Parts and Functions 

On smartphones, these settings may be under “Pro” or “Manual” mode. 

 

Using a Smartphone Camera 

1. Clean the Lens: fingerprints reduce clarity. 

2. Set Resolution to the highest available (e.g., 1080p or 4K). 

3. Use the Rear Camera: it’s sharper than the front camera. 

4. Use Grid Lines: activate the “rule of thirds” grid for balanced framing. 

5. Tap to Focus: tap the subject to ensure sharpness. 

6. Lock Exposure: on most phones, hold your finger on the screen until AE/AF Lock appears. 

7. Stabilize the Phone: use a tripod or rest it on a steady surface. 

8. Record horizontally or vertically depending on platform (see below). 

9. Avoid Digital Zoom: move closer physically for better detail. 

10. Use Natural Light whenever possible. 

 

Using a Standalone Camera (DSLR or Mirrorless) 

1. Insert and format memory card before shooting. 

2. Switch to Manual (M) or Semi-Auto (Aperture or Shutter Priority) mode. 
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3. Adjust the exposure triangle: 

✓ Aperture (f/stop): Low number (e.g., f/2.8) = blurred background. High number (f/8–f/11) 

= more focus. 

✓ Shutter Speed: 1/50–1/100 for standard shots; faster for sports/action. 

✓ ISO: Keep as low as possible (100–400) for clean images. 

4. Set White Balance based on lighting (daylight, shade, tungsten, etc.). 

5. Focus manually or with autofocus depending on movement. 

6. Check framing and headroom before recording. 

7. Monitor audio if recording sound: use an external mic if possible. 

8. Record in short clips and review them regularly. 

 

Taking Photos 

• Rule of Thirds: Place subject slightly off-center. 

• Leading Lines: Use roads, fences, or light to direct attention. 

• Framing: Shoot through windows, doors, or trees for depth. 

• Symmetry: Balanced and professional look. 

• Depth: Include foreground, middle, and background elements. 

Lighting Tips 

• Golden Hour: Early morning or late evening = soft, warm light. 

• Avoid Midday Sun: Too harsh, causes shadows. 

• Use Reflectors: Bounce natural light onto faces. 

• Indoor Lighting: Use soft light (lamps, ring lights, or diffusers). 

 

Taking Video Footage 

1. Plan shots before recording (based on your storyboard). 

2. Use a tripod or gimbal for stability. 

3. Shoot in short segments (5–10 seconds each). 

4. Capture multiple angles: wide, medium, and close-ups. 

5. Record ambient sound: adds realism in editing. 

6. Avoid shaky movements unless intentional. 

7. Keep your camera level and horizon straight. 

8. Use manual focus for cinematic depth if possible. 
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Shooting for Different Platforms 

Platform Orientation Resolution Frame 

Rate 

Style Tips 

YouTube Horizontal (16:9) 1080p or 

4K 

24–30 fps Long-form storytelling, 

interviews, tutorials 

Instagram Feed Square (1:1) or 

Portrait (4:5) 

1080p 30 fps Bright visuals, short scenes, 

captions 

Instagram Stories 

/ Reels 

Vertical (9:16) 1080p 30–60 fps Snappy transitions, text 

overlays 

TikTok Vertical (9:16) 1080p 30–60 fps Fun, energetic, trendy angles 

Facebook Horizontal (16:9) or 

Square 

720p–

1080p 

30 fps Clear visuals, direct 

engagement 

Website / Blog Horizontal (16:9) 1080p 24–30 fps Clean, minimal, storytelling 

shots 

Table 11: Shooting for Different Platforms 

Always frame your subject according to where it will appear (e.g., vertical for phone viewers). 

 

Storytelling Through the Lens 

Even with great visuals, story drives engagement. Use the following structure: 

1. Opening / Hook: grab attention immediately. 

2. Middle / Message: the main action or point. 

3. Ending / Call-to-Action: conclusion or next step (subscribe, share, reflect, etc.). 

Always ask: “What emotion or message am I trying to show in this shot?” 
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Editing and Post-Shooting Essentials 

Once footage or photos are taken: 

For Videos 

• Trim clips, add transitions, captions, and background music. 

• Balance color and brightness. 

• Add your logo or watermark. 

• Export in correct format (MP4, H.264 codec). 

Free Video Editing Tools: 

• CapCut 

• DaVinci Resolve 

• VN Video Editor 

• Canva Video Editor 

• Lightworks 

For Photos 

• Crop to platform ratio. 

• Adjust exposure, contrast, and saturation. 

• Add filters lightly: keep it natural. 

Free Photo Editors: 

• Snapseed 

• Canva 

• Lightroom Mobile 

• Pixlr 
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AI Tools That Can Help 

Tool Use Case 

ChatGPT Write scripts, video ideas, or captions 

Runway ML AI video editing and background removal 

Pika Labs / Synthesia Generate AI-assisted video scenes 

Remini / ClipDrop Enhance image or video quality 

Descript AI-based audio cleanup and transcription 

Canva Magic Studio Design thumbnails and overlays easily 

Table 12: AI Tools That Can Help 

Key Mistakes to Avoid 

• Shooting without checking your lighting or background 

• Forgetting to clean the lens 

• Overusing zoom 

• Not charging batteries or clearing storage 

• Recording vertically for YouTube (or horizontally for TikTok) 

• Ignoring audio quality 

• Forgetting to back up your footage 

 

Camera Use Checklist 

1. Clean lens 

2. Set resolution & frame rate 

3. Lock focus & exposure 

4. Frame subject properly 

5. Check lighting 

6. Record test clip 

7. Monitor audio 

8. Back up footage immediately 
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What Are Image and Video Formats? 

A format is the type of file used to store digital media (image, video, audio). 

It determines: 

• The quality of the media 

• The file size 

• The compatibility with devices, software, and platforms 

Different formats serve different purposes: e.g., social media, websites, printing, or video editing. 

 

Image formats 

Format File 

Extension 

Best For Advantages Disadvantages 

JPEG / 

JPG 

.jpg / .jpeg Web, social media, 

photography 

Small file size, 

widely supported 

Loses quality when 

repeatedly edited/saved 

PNG .png Logos, graphics, 

transparent images 

High quality, supports 

transparency 

Larger file size 

GIF .gif Animations, short 

loops 

Small, animated Limited colors, not 

suitable for photos 

WEBP .webp Websites (modern 

browsers) 

High quality at small 

size 

Not supported everywhere 

TIFF / 

TIF 

.tiff Printing, archiving Very high quality Large files 

RAW .raw, .cr2, 

.nef 

Professional 

photography 

Full detail, editable Requires conversion, large 

size 

SVG .svg Icons, logos, 

infographics 

Scalable without 

losing quality 

Not suitable for photos 

HEIC / 

HEIF 

.heic iPhones (modern 

format) 

High compression, 

high quality 

Limited compatibility on 

some devices 

Table 13: Image formats 
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Image Format Recommendations 

Use Case Recommended Format 

Website graphics WEBP or PNG 

Social media posts JPEG or PNG 

Transparent logo PNG or SVG 

Print materials TIFF or PDF 

Animation / memes GIF 

Photography (editing) RAW 

Photography (sharing) JPEG 

Table 14: Image Format Recommendations 

 

Video formats 

Format File 

Extension 

Best For Advantages Disadvantages 

MP4 (H.264 

/ H.265) 

.mp4 YouTube, TikTok, 

Instagram, most 

platforms 

Small, high-quality, 

widely supported 

Few editing options 

MOV .mov Apple devices, editing High quality Larger size 

AVI .avi Older systems, editing High quality Big file size 

WMV .wmv Windows platforms Compressed Not widely used 

online 

MKV .mkv Archiving, long videos Supports subtitles, 

multiple audio tracks 

Not always 

compatible 

FLV .flv Legacy Flash videos Lightweight Outdated 
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WEBM .webm Websites (modern 

browsers) 

Lightweight Not widely used 

outside web 

3GP .3gp Old phones Small file Poor quality 

Table 15: Video formats 

 

Video Format Recommendations 

Use Case Recommended Format Resolution & Frame Rate 

YouTube MP4 (H.264 or H.265) 1080p, 24–30 fps 

TikTok / Instagram Reels MP4 (vertical) 1080p, 30–60 fps 

Facebook MP4 720p–1080p, 30 fps 

Website embeds WEBM or MP4 720p, 30 fps 

Professional editing MOV or AVI 4K or ProRes codec 

Archiving or backups MKV 1080p–4K 

WhatsApp / Mobile sharing MP4 (compressed) 720p 

Table 16: Video Format Recommendations 

 

Video Codecs  

A codec (compressor–decompressor) defines how a video file is encoded and decoded. 

Codec Used In Advantages 

H.264 MP4 High quality, small size, widely supported 

H.265 (HEVC) 4K MP4 Better compression, smaller size 

ProRes MOV High quality for editing 

VP9 WEBM Used for YouTube HD/4K 
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AV1 Future codec High efficiency, open-source 

Table 17: Video Codecs 

 

Best Practices for Choosing Formats 

1. Always plan your output first: Is it for the web, print, or video? 

2. Balance quality vs file size: Large files slow down uploads. 

3. Keep masters in high quality (RAW or 4K), then export in smaller versions. 

4. Use lossless formats (PNG, TIFF, MOV) for editing. 

5. Use compressed formats (JPG, MP4, WEBP) for sharing. 

 

Free AI Platforms for Generating Images 

AI Platform Use Website / Tool 

Canva Magic Media Generate AI images from text canva.com 

Bing Image Creator (DALL·E) Realistic AI image generation bing.com/create 

Pixlr AI background removal, image editing pixlr.com 

Fotor AI Generate art and photo edits fotor.com 

NightCafe AI art creation nightcafe.studio 

Craiyon Free text-to-image generator craiyon.com 

Leonardo.Ai Generate cinematic or stylized visuals leonardo.ai 

Designify / Remove.bg Background remover, quick design designify.com / remove.bg 

Table 18: Free AI Platforms for Generating Images 

 

Free AI Platforms for Generating Videos 

AI Tool Main Feature Website / Use 

https://www.canva.com/
https://bing.com/create
https://pixlr.com/
https://www.fotor.com/
https://nightcafe.studio/
https://www.craiyon.com/
https://leonardo.ai/
https://www.designify.com/
https://www.remove.bg/
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Pika Labs AI video generation from text or images pika.art 

Runway ML Text-to-video, video editing, background removal runwayml.com 

Synthesia Create AI presenter videos from scripts synthesia.io 

HeyGen Avatar-based video creation heygen.com 

Animoto Turn photos and clips into social videos animoto.com 

Kaiber Turn still images into moving AI videos kaiber.ai 

Lumen5 Convert articles or scripts into social videos lumen5.com 

InVideo Text-to-video editing invideo.io 

Pictory Turn text or blog posts into videos pictory.ai 

Table 19: Free AI Platforms for Generating Videos 

 

Free AI Platforms That Convert Picture to Video 

Platform Function Use Case 

Kaiber.ai Turns an image into a moving video Great for intros or animated art 

Runway ML Gen-2 Converts still images to cinematic videos Professional storytelling 

Pika Labs Creates animated scenes from photos YouTube intros, storytelling 

CapCut AI Adds motion effects to images TikTok / Reels 

Animoto Converts photos into slideshows with music Event or ministry highlights 

Table 20: Free AI Platforms That Convert Picture to Video 

 

Free AI Platforms That Convert Words (Text) to Video 

Platform Function Best For 

Pictory Turns scripts or blog posts into narrated videos Educational or devotional videos 

https://pika.art/
https://runwayml.com/
https://www.synthesia.io/
https://www.heygen.com/
https://animoto.com/
https://www.kaiber.ai/
https://www.lumen5.com/
https://www.invideo.io/
https://pictory.ai/
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Lumen5 Converts text into social videos Marketing or storytelling 

Synthesia Turns text into avatar-based videos Corporate / training videos 

HeyGen Generates talking head avatars from text Presentations, announcements 

InVideo Converts text into dynamic social videos Short-form videos 

Runway ML Advanced text-to-video generation Creative storytelling / art projects 

Table 21: Free AI Platforms That Convert Words (Text) to Video 

 

Free AI Platforms That Generate Graphics or Designs 

Platform Use Case Features 

Canva Graphics, posters, social media posts Templates, AI design tools 

Crello (VistaCreate) Social media graphics Ready-made designs 

Fotor AI image generator + editor Filters and enhancements 

Snappa Simple graphic design tool Marketing materials 

Adobe Express Posters, thumbnails, and banners Templates + brand tools 

Desygner Logos, flyers, social media Free and easy online editor 

Photopea Photoshop alternative (online) Works with PSD, PNG, JPG 

Simplified.com AI content + design + social scheduler One-stop creative suite 

Table 22: Free AI Platforms That Generate Graphics or Designs 

 

Best Practices for AI-Generated Media 

1. Always review AI results: ensure they match your brand or message. 

2. Avoid copyrighted or sensitive visuals. 

3. Add your own voice, logo, or style to personalize AI content. 

4. Use AI to assist, not replace creativity. 

5. Export in web-optimized formats (e.g., PNG for images, MP4 for video). 

6. Compress media before uploading to save space. 
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7. Keep consistent dimensions across all platforms. 

 

Recommended Export Settings for Content Creators 

Platform Video Format Resolution Image Format 

YouTube MP4 (H.264) 1080p–4K JPEG (thumbnail) 

Instagram MP4 (Vertical) 1080x1920 PNG or JPEG 

TikTok MP4 (Vertical) 1080x1920 PNG or JPEG 

Facebook MP4 720p–1080p JPEG 

Website / Blog WEBM or MP4 720p WEBP or PNG 

Print / Posters MOV or ProRes (if video) 4K TIFF / PDF / PNG 

Table 23: Recommended Export Settings for Content Creators 

Reference Summary 

Need Best Format AI Tool Recommendation 

Social media image PNG / JPEG Canva, Fotor, Pixlr 

Transparent logo PNG / SVG Photopea, Canva 

Blog illustration WEBP DALL·E / Bing Image Creator 

YouTube video MP4 Pictory, Runway ML 

TikTok video MP4 (vertical) Kaiber, CapCut 

Article → video Pictory / Lumen5 Script + auto visuals 

Picture → animated video Kaiber / Pika Labs Cinematic motion 

Poster / flyer design Canva / VistaCreate Graphic templates 

Table 24: Reference Summary 
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Leonardo.Ai 

Leonardo is an AI creative studio for generating images, editing them on a canvas, upscaling, training 

custom models (“Elements”), and more recently generating video with models such as Sora / Veo. It 

includes a realtime canvas, image→image, universal upscaler, model library, and community presets.  

Create an account & understand pricing / tokens 

1. Visit leonardo.ai and sign up with email or SSO. The free tier exists (no credit card required) and 

gives a daily token allotment for generation; paid plans increase tokens, private generations, 

model training and advanced features.  

2. Check the Pricing page so you know your token limits and what Private/Public options each plan 

gives. (Free = public creations; paid tiers unlock private/full ownership and more tokens).  

Why tokens matter: Each generation consumes tokens (fast tokens vs relaxed), so monitor usage when 

iterating on prompts. 

Learn the workspace  

• Create / Generate (text-to-image): type prompts, pick model/preset, generate variations. 

• Image to Image: upload an image and use it as a reference or to transform that input. 

• Canvas / Realtime Canvas: an editor where you can paint, extend, or inpaint (useful for 

composition changes). 

• Upscaler: enhances resolution and detail of outputs. 

• Elements (Train custom models): train LoRA-like elements for brand/character consistency. 

• Community models & presets: ready styles created by other users.  

 

First image step-by-step 

1. Open Leonardo → click Create / Generate. 

2. Choose a model (e.g., PhotoReal, Phoenix, or other named model) : models affect style and face 

quality. 

3. Write a clear prompt (see prompt tips below). Optionally add negative prompts to avoid 

undesired elements. 

4. Set size & quality (1024×1024 common; higher may cost more tokens). 

5. Generate → you’ll get a grid of variations. 

6. Select any variant to refine: use variations, upscale, or canvas edit. 

7. Download the final image or save to a collection. 
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Official docs and a “Formatting a basic prompt” guide are helpful for first prompts. 

 

Prompting  

• Be specific (subject, mood, lighting, camera, art style, color palette). 

• Use style tokens: e.g., “photorealistic, 50mm, soft rim light, cinematic color grade.” 

• Add composition cues: “close-up, shallow depth of field, rule of thirds.” 

• Use negative prompts: “no text, no watermarks, avoid extra limbs.” 

• Keep iterations: tweak one variable at a time (e.g., change lighting then camera). 

Example prompt (photoreal): 

"INT. CHURCH - morning light through stained glass; close-up of an open Bible on wooden pew; 

shallow depth of field; warm rim light; photorealistic; 35mm lens; detailed paper texture; film grain 

35mm." 

Then ask Leonardo to produce variations and upscale the best result. 

See Leonardo’s in-platform prompt formatting guide for exact syntax. 

 

Image to Image & Canvas editing 

• Image to Image: upload a photo, provide an instruction (e.g., “make this sunset golden, remove 

background”). This is great for style transfer or edits. 

• Realtime Canvas: sketch or paint rough shapes and watch the model convert sketches into refined 

images : excellent for composition and ideation.  

 

Upscaling & finishing 

• Use Universal Upscaler to increase resolution and detail for print or close crops. Upscaling is a 

separate step after generation and improves clarity without re-generating. 

 

Train Elements (custom models / consistent characters) 
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• If you need consistent characters, products, or styles, use Element Training to create reusable 

assets (train using a dataset of examples). This improves consistency across many generations 

(useful for brands, characters). Training options and docs explain settings and dataset size. 

 

Video generation basics (Sora / Veo / video tools) 

• Leonardo has video models (Sora / Veo) and guidance for text to video workflows (camera 

control, multi-shot prompts). These are more experimental and often require more tokens or paid 

access. Check Leonardo Learn for Sora guides and recommended workflows. 

 

Exporting, collections & sharing 

• Save outputs to collections (free tier has limited personal collections). 

• Download as PNG/JPEG or export high-res upscaled versions for print. 

• For team workflows, paid tiers support multiple collections and privacy settings.  

 

Ownership & commercial use (important) 

• Paid subscribers: Leonardo states paid users retain full ownership/copyright for their generated 

images. Free tier: creations are public by default; Leonardo’s terms indicate they may use public 

content and that free users receive a non-exclusive royalty-free licence to use images 

commercially: but the platform retains broader rights to public content. Always read the Terms 

and Pricing pages carefully before commercial or client use. 

If you need guaranteed private ownership for client work or products to sell, prefer a paid plan and keep 

outputs private. 
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Best practices & workflows 

• Save your prompt each iteration so you can reproduce results. 

• Use reference images for look consistency. 

• Train Elements for brand/character consistency if you’ll generate many assets.  

• Check legal / DMCA risks: avoid uploading copyrighted images you don’t own; Leonardo has a 

DMCA policy and may act on repeat infringement. 

• Use Leonardo Learn & webinars to keep up with new models and tips (they publish official 

prompt recipes and webinars).  

 

Troubleshooting common issues 

• Faces look odd: try a different model (PhotoReal/Alchemy), higher quality settings, or upscaling.  

• Too slow / low tokens: switch to relaxed generation (if available) or upgrade plan. 

• Watermarks or low quality on free: remember free tier has limitations and public generation 

defaults. Consider upgrading for private, higher-quality outputs. 

 

Sound & audio production 

Sound (audio) is one of the most powerful tools in media, it communicates emotion, clarity, and 

professionalism. Good sound quality can make even a simple video or podcast feel cinematic and 

trustworthy. Sound in content creation includes: 

• Voice recordings (speech, narration, dialogue) 

• Music (background, intro, outro) 

• Sound effects (SFX) 

• Ambience / background audio (environment sounds) 

• Foley sounds (recreated everyday sounds for realism) 
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Types of audio file formats 

Format File 

Extension 

Type Best Used For Pros Cons 

MP3 .mp3 Compressed 

(Lossy) 

Podcasts, YouTube, 

web sharing 

Small size, 

universal 

Slight loss in 

quality 

WAV .wav Uncompressed 

(Lossless) 

Professional 

recording, editing 

High quality Large file size 

AAC .aac Compressed Streaming, 

YouTube, Apple 

Music 

Better quality 

than MP3 at 

same bitrate 

Not editable in 

all software 

FLAC .flac Lossless 

compressed 

Music archiving, 

high-quality 

playback 

Keeps full detail Larger than 

MP3 

AIFF .aiff Uncompressed 

(Apple) 

Mac-based editing Studio quality Large files 

OGG .ogg Compressed 

(open-source) 

Gaming, web audio Free, flexible Less 

supported 

M4A .m4a Compressed 

(AAC codec) 

iTunes, podcasts Good quality Not ideal for 

pro editing 

WMA .wma Compressed Windows audio Compact Not widely 

supported now 

Table 25: Types of audio file formats 

 

Audio Format Recommendations 

Use Case Recommended Format 

Recording and Editing WAV or AIFF 

Uploading to YouTube / Podcasts MP3 or AAC 

Archiving / Music Storage FLAC 
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Game / Web Apps OGG 

Mobile Playback MP3 

Broadcast Radio WAV (for quality), MP3 (for transmission) 

Table 26: Audio Format Recommendations 

 

Types of microphones and their uses 

Microphones differ by pickup pattern, use case, and connection type. 

✓ By Pickup Pattern 

Type Pattern Shape Captures Sound 

From 

Best For 

Omnidirectional All directions 360° around the 

mic 

Interviews, capturing natural 

ambience 

Cardioid Heart-shaped (front-

focused) 

Front of mic Vocals, podcasts, YouTube 

videos 

Supercardioid / 

Hypercardioid 

Narrow front, small 

rear 

Mainly front Film, outdoor recording, 

noise isolation 

Bidirectional (Figure-8) Front and back Two opposite 

sides 

Duet podcasts, two-person 

interviews 

Shotgun Mic Very narrow front Long-distance 

focus 

Film, vlogs, church sermons 

Table 27: By Pickup Pattern 

 

✓ By Design Type 

Microphone Type Description Best Used For 

Dynamic Mic Durable, no external power needed Live vocals, events, speeches 
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Condenser Mic Sensitive, needs phantom power 

(48V) 

Studio voice recording, singing, 

podcasting 

Lavalier (Lapel) Mic Small clip-on mic Interviews, sermons, vlogs 

Shotgun Mic Long tube shape, directional Film sets, outdoor shoots 

USB Mic Plug-and-play Online meetings, podcasts, streaming 

Wireless Mic Battery powered, transmitter + 

receiver 

Stage, church, event videos 

Boundary / Surface 

Mic 

Flat mic on a surface Conferences, boardroom meetings 

Table 28: By Design Type 

 

Microphone Positioning  

1. Keep mic 6–12 inches from the mouth (for speech). 

2. Use a pop filter to reduce “p” and “b” pops. 

3. Record in a quiet, echo-free environment. 

4. Use foam windscreens or deadcats outdoors to block wind. 

5. Angle shotgun mics toward the mouth, not the chest. 

6. Always monitor sound with headphones while recording. 

Types of sound in content creation 

Sound Type Purpose / Example 

Dialogue / Voice-over Narration, teaching, preaching, commentary 

Music (Background / Intro) Adds mood, energy, or transition 

Sound Effects (SFX) Buttons, doors, footsteps, birds, etc. 

Ambient Sounds Background environment (street noise, wind) 

Foley Sounds Manually recreated natural sounds 

Silence / Room Tone Used to smooth audio edits in post-production 

Table 29: Types of sound in content creation 
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Sound recording software (daws) 

DAW = Digital Audio Workstation (software used to record, edit, and mix sound). 

Software Type Best For Platform 

Audacity Free Basic recording, editing Windows / Mac / 

Linux 

GarageBand Free Music & podcast production macOS / iOS 

Adobe Audition Paid Professional post-production Windows / Mac 

Reaper Paid (cheap license) Full-featured DAW Windows / Mac 

Cakewalk by 

BandLab 

Free Multitrack recording Windows 

Ocenaudio Free Quick edits and analysis Cross-platform 

Pro Tools Paid (industry 

standard) 

Studio-grade production Windows / Mac 

FL Studio Paid Music creation & beats Windows / Mac 

Logic Pro X Paid Advanced music & podcast 

editing 

macOS 

Table 30: Sound recording software (daws) 

 

Free ai platforms that generate sound / music / voice 

AI Tool Main Use Website / Notes 

Soundraw.io AI-generated music For background or mood music 

Mubert Royalty-free AI music generator Ideal for YouTube / Reels 

Aiva.ai AI composer for background tracks Great for film scoring 

Boomy Create songs in seconds Beginner-friendly 
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Beatoven.ai Generates mood-based music for 

videos 

Indian-made, royalty-free 

LALAL.AI Splits vocals & instruments Great for remixing or sound 

cleanup 

ElevenLabs Realistic AI voice generation Narration or voice-over 

Play.ht Text-to-speech AI Convert blog or script to podcast 

Descript AI voice cloning + podcast editing All-in-one tool 

Podcastle.ai Record, edit, and enhance voice with 

AI 

For podcasters 

Adobe Podcast 

Enhance 

AI tool to clean up poor audio Free online tool (speech enhancer) 

Table 31: Free AI platforms that generate sound / music / voice 

 

Sound editing & enhancement tools 

Tool Use Function 

Audacity Noise removal, equalization, trimming Manual edits 

Adobe Audition Advanced mixing, multitrack Professional post 

Krisp.ai Removes background noise in real time Meetings & live streams 

Auphonic Automatic volume leveling & mastering Podcasts, voice 

Descript Text-based editing (edit words, fixes sound) Smart, AI-powered 

Veed.io / Kapwing Add subtitles + edit audio in video For creators 

Reaper Mixing, sound design Pro audio tool 

Audionamix / RX Elements Clean up bad recordings Removes hiss, hum, clicks 

Table 32: Sound editing & enhancement tools 

 

SOUND DESIGN PRINCIPLES (FOR CONTENT CREATORS) 
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1. Clarity: Voice should be crisp and clear. 

2. Consistency: Maintain equal volume across clips. 

3. Emotion: Choose background music that matches mood. 

4. Space: Avoid too many overlapping sounds. 

5. Silence: Use pauses strategically for drama or reflection. 

6. Layering: Combine ambient + voice + effects + music carefully. 

7. Balance: Ensure voice is always louder than background music. 

 

Sound in different platforms 

Platform Recommended Format Sound Tips 

YouTube MP3 / AAC / WAV Use stereo sound, balance music under -12 dB 

TikTok / Reels MP3 / M4A Use trending sounds; ensure voice clarity 

Podcasts MP3 (128 kbps+) Loudness between -16 and -14 LUFS 

Facebook / Instagram MP3 / AAC Keep under 60s for engagement 

Film / Church Media WAV / AIFF Record separate dialogue and ambient tracks 

Radio WAV Maintain consistent EQ for voice 

Games / Apps OGG / WAV Compress without losing clarity 

Table 33: Sound in different platforms 

 

Recording great sound 

1. Record in a quiet space: turn off fans or AC. 

2. Use proper mic technique: steady distance and direction. 

3. Monitor with headphones: catch noise early. 

4. Avoid clipping: keep input levels below 0 dB. 

5. Record a few seconds of “room tone.” 

6. Use pop filters & shock mounts for clean vocals. 

7. Keep multiple takes: easier to fix mistakes. 

8. Label files clearly (e.g., “Intro_VoiceTake2.wav”). 
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Copyright & music licensing 

When adding background music: 

• Use royalty-free or AI-generated music (Mubert, Soundraw, Beatoven). 

• Always credit the creator if required. 

• Avoid using copyrighted songs from Spotify or YouTube directly. 

• For church or events, consider a CCLI license or use Creative Commons tracks. 

 

Summary table 

Category Best Options Examples / Notes 

Recording format WAV, AIFF High-quality audio 

Publishing format MP3, AAC Compressed for web 

Microphone type Condenser / Lavalier Speech / vocals 

AI sound tools Soundraw, Mubert, Aiva Generate background music 

Voice tools ElevenLabs, Play.ht Create narration 

Recording software Audacity, GarageBand Free for beginners 

Editing software Audition, Descript Clean, mix, enhance 

Noise reduction Adobe Podcast Enhance, Krisp Improve clarity 

Table 34: Summary table 

 

ADDITIONAL RESOURCES 

• Freesound.org – free sound effects 

• Mixkit.co – royalty-free music 

• EpidemicSound.com – paid music for creators 

• YouTube Audio Library – free background tracks 
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• BBC Sound Effects Archive – high-quality ambient sounds 

 

Where to download free photos and audios: and how to use them safely 

Why use free (royalty-free) media? 

Free-to-download photos and audios are often shared under Creative Commons licenses or public domain. 

They help creators avoid copyright strikes or legal issues when publishing online (especially on YouTube, 

social media, blogs, or apps). 

Common License Types 

License Type Meaning What You Can Do 

Public Domain (CC0) No copyright Use freely, even commercially, no credit 

needed 

Creative Commons (CC 

BY) 

Must credit creator Free use, but include attribution 

CC BY-SA Credit + share alike Must share your version under same license 

CC BY-NC Non-commercial Use for personal/educational purposes only 

Royalty-Free No ongoing payments Usually free, but read the site’s terms 

Stock License (Free Tier) Limited use under site 

rules 

Free with possible restrictions 

Table 35: Common License Types 

Always read the license or usage terms before downloading. 

 

Where to download free photos 

Below are the best reliable platforms offering high-quality, royalty-free images for any use. 

Pexels : https://www.pexels.com 

https://www.pexels.com/
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What you get: 

• Free high-quality stock photos & videos 

• No attribution required (though appreciated) 

• Ideal for blogs, YouTube thumbnails, and presentations 

How to download: 

1. Go to the website. 

2. Search for your image (e.g., “church service,” “nature,” “technology”). 

3. Click the image you like. 

4. Press Download (choose desired resolution). 

 

Pixabay : https://pixabay.com 

What you get: 

• Over 2.8 million free images, videos, and music 

• All content released under Pixabay License (free for commercial use) 

How to download: 

1. Search your keyword (e.g., “classroom,” “camera,” “cross”). 

2. Choose your preferred photo. 

3. Click Free Download → select size → verify captcha → download. 

 

Unsplash : https://unsplash.com 

What you get: 

• Artistic, professional-quality photos 

• No copyright restrictions 

• Great for branding, blogs, and creative projects 

How to download: 

https://pixabay.com/
https://unsplash.com/
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1. Go to Unsplash.com. 

2. Enter a keyword (e.g., “African landscape,” “microphone,” “city lights”). 

3. Click the image → press the Download arrow icon. 

 

Freepik : https://www.freepik.com 

What you get: 

• Free photos, illustrations, icons, and templates 

• Requires attribution unless you have a premium plan 

How to download: 

1. Search your item (e.g., “infographic template,” “office background”). 

2. Select a Free resource. 

3. Click Free Download → credit the creator as required. 

 

Canva : https://www.canva.com 

What you get: 

• Free stock photos integrated with design tools 

• Ideal for posters, social media, or slides 

How to download: 

1. Create a free account. 

2. Search or start a design. 

3. Add photos from the “Elements” tab. 

4. Click Share → Download → JPG/PNG. 

 

Burst by Shopify : https://burst.shopify.com 

https://www.freepik.com/
https://www.canva.com/
https://burst.shopify.com/
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What you get: 

• Business and lifestyle-focused free images 

• Great for website banners, ads, and product mockups 

How to download: 

1. Visit Burst.shopify.com. 

2. Browse or search photos. 

3. Click on your favorite image. 

4. Download in high or low resolution. 

 

StockSnap.io : https://stocksnap.io 

What you get: 

• Thousands of new CC0 images weekly 

• No attribution required 

How to download: 

1. Search your topic. 

2. Click image → press Free Download. 

 

Kaboompics : https://kaboompics.com 

What you get: 

• Stylish lifestyle and interior photos 

• Free for personal and commercial use 

• Requires optional credit 

 

Using Free Photos Safely 

https://stocksnap.io/
https://kaboompics.com/
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• Always read the image license carefully. 

• Avoid using images with identifiable people or brands in ads without consent. 

• For YouTube thumbnails, use landscape format (1280×720 px). 

• For blogs or websites, optimize by resizing to under 200 KB for faster loading. 

• You can use Canva or Pixlr to edit or resize images before uploading. 

 

Where to download free audios (music & sound effects) 

Now let’s look at trusted, copyright-safe audio sources for music, podcasts, films, or social media. 

YouTube Audio Library : https://www.youtube.com/audiolibrary 

What you get: 

• 100% free music and sound effects 

• For YouTube, podcasts, or other media 

• Royalty-free and easy to use 

How to download: 

1. Log in to YouTube Studio. 

2. Go to Audio Library on the sidebar. 

3. Browse by genre, mood, or duration. 

4. Click Download beside the track you like. 

 

Free Music Archive (FMA) : https://freemusicarchive.org 

What you get: 

• Curated, legal audio under Creative Commons licenses 

• Thousands of genres from ambient to gospel 

How to download: 

1. Search or browse genres. 

2. Click the song title → Download MP3. 

https://www.youtube.com/audiolibrary
https://freemusicarchive.org/
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3. Check the license (some need attribution). 

 

Bensound : https://www.bensound.com 

What you get: 

• Royalty-free music (attribution required) 

• Great for intros, presentations, background tracks 

How to download: 

1. Browse by style (corporate, cinematic, inspirational, etc.). 

2. Select Free Download (with credit). 

Mixkit : https://mixkit.co 

What you get: 

• Free stock music, sound effects, and video clips 

• No attribution required 

How to download: 

1. Visit Mixkit.co. 

2. Go to Music or Sound Effects. 

3. Click on a track → Download Free. 

 

Incompetech : https://incompetech.com/music/royalty-free 

What you get: 

• Royalty-free tracks by Kevin MacLeod 

• Free use with credit 

How to download: 

https://www.bensound.com/
https://mixkit.co/
https://incompetech.com/music/royalty-free
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1. Choose genre. 

2. Preview and click Download MP3. 

3. Add the credit line in your description. 

 

SoundBible : https://soundbible.com 

What you get: 

• Free sound effects (animal sounds, ambient, etc.) 

• Mix of public domain and attribution-required clips 

How to download: 

1. Search for a sound. 

2. Click the Download WAV/MP3 button. 

 

 Jamendo : https://www.jamendo.com/start 

What you get: 

• Free music for personal projects (requires credit) 

• Licensed commercial options available 

 

Zapsplat : https://www.zapsplat.com 

What you get: 

• Over 100,000 free SFX and background sounds 

• Attribution required (unless premium) 

How to download: 

1. Sign up for a free account. 

https://soundbible.com/
https://www.jamendo.com/start
https://www.zapsplat.com/
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2. Browse and click the sound → Download. 

 

Epidemic Sound (Trial) : https://www.epidemicsound.com 

What you get: 

• Free trial for premium royalty-free tracks 

• Used by YouTubers & podcasters globally 

• Requires subscription after trial 

 

How to use free media correctly 

Always Check the License 

• CC0 = No credit needed. 

• CC BY = Must give credit. 

• CC BY-NC = Non-commercial only. 

How to Give Proper Credit 

Example credit format: 

“Music: ‘Inspire’ by Bensound (https://www.bensound.com) : Licensed under Creative Commons 

Attribution 4.0.” 

Organize Your Media Library 

• Create folders like: 

✓ Photos → Backgrounds / People / Objects 

✓ Audio → Music / Voice / SFX 

• Rename files clearly (e.g., Calm_Music_Pexels.mp3). 

Compress Before Uploading 

• Use tools like TinyPNG (for images) or MP3Smaller (for audio). 

https://www.epidemicsound.com/
https://www.bensound.com/
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• Keeps your website or video light and fast. 

 

Free ai platforms for media creation 

AI Tool What It Does Use Case 

Pixlr AI photo editor Resize, enhance free photos 

Leonardo.ai AI image generation Create unique visuals 

Pexels AI Search Smart image finder Suggests related free images 

Mubert AI music generator Create royalty-free soundtracks 

Soundraw.io Compose AI background 

music 

For YouTube / church videos 

Adobe Podcast 

Enhance 

AI voice cleanup Makes poor recordings sound studio-

quality 

Table 36: Free AI platforms for media creation 

 

Quick summary table 

Category Platform License Type Attribution Required? 

Free Photos Pexels CC0 No 

Free Photos Pixabay Pixabay License No 

Free Photos Unsplash Unsplash License No 

Free Photos Freepik CC BY Yes 

Free Audio YouTube Audio Library Royalty-Free No 

Free Audio FMA CC Sometimes 

Free Audio Bensound CC BY Yes 

Free SFX Mixkit Free License No 
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Free SFX Zapsplat Free License Yes (for free plan) 

Table 37: Quick summary table 

 

Video editing 

What is video editing? 

Video editing is the process of selecting, arranging, and modifying video clips, images, sound, and effects 

to tell a story or deliver a message. It transforms raw footage into a polished final product: suitable for 

YouTube, social media, films, training videos, or church broadcasts. 

Goals of Video Editing 

• Communicate a clear message or story. 

• Create emotional impact through pacing, tone, and visuals. 

• Add graphics, transitions, and sound for a professional finish. 

• Correct color, brightness, and sound for consistency. 

 

The video editing workflow 

Stage Description Tools Involved 

Importing Bring your video, images, and audio into the software. Phone, camera, PC 

Organizing Arrange clips in order, name files, create folders. File explorer, bins 

Rough Cut Trim and order clips to form the story sequence. CapCut, Premiere Pro 

Fine Cut Adjust timing, sync sound, smooth transitions. Editing timeline 

Effects & Graphics Add text, filters, overlays, motion graphics. After Effects, CapCut 

Color Correction Adjust brightness, contrast, color tone. Lumetri, CapCut filters 

Sound Editing Add voiceovers, remove noise, balance levels. Audition, Descript 

Exporting Save in correct format and resolution. MP4, MOV, AVI 

Table 38: The video editing workflow 
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Types of video editing software 

There are 3 main categories of video editing tools depending on skill level and use case: 

✓ Beginner-Friendly / Mobile Apps 

Software Platform Features 

CapCut Android, iOS, Windows, Mac Easy drag-and-drop, filters, auto captions 

VN Editor Mobile/Desktop Transitions, music, overlays 

InShot Mobile Fast editing for Reels & Shorts 

KineMaster Mobile Multilayer timeline, chroma key 

Canva Video Editor Web Templates, stock videos, AI tools 

Clideo / FlexClip Web Online simple editor 

Table 39: Beginner-Friendly / Mobile Apps 

 

✓ Intermediate / Prosumer Software 

Software Platform Features 

Filmora Windows/Mac User-friendly, AI tools, effects library 

DaVinci Resolve Windows/Mac/Linux Professional color grading, editing, audio 

HitFilm Express Windows/Mac VFX & editing combo 

Shotcut / OpenShot Free Basic to mid-level editing 

Table 40: Intermediate / Prosumer Software 

 

Professional Software 
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Software Used For Notes 

Adobe Premiere Pro Industry-standard video editing Used in film, YouTube, media houses 

Final Cut Pro X Apple users Fast, efficient, high-quality editing 

Avid Media 

Composer 

Hollywood films Advanced color, motion, and audio 

controls 

DaVinci Resolve 

Studio 

High-end color grading & post-

production 

Free + paid versions 

Table 41: Professional Software 

 

How to use capcut  

CapCut is one of the easiest and most powerful free editors for mobile and desktop creators. 

Step 1: Install and Open CapCut 

• Download from https://www.capcut.com or your app store. 

• Open the app → click New Project. 

Step 2: Import Media 

• Tap + to select videos, photos, and audio from your device. 

• The files will appear on your timeline. 

Step 3: Trim and Split Clips 

• Tap a clip → drag the edges to trim. 

• Use Split to cut a clip into two parts (for transitions or cuts). 

Step 4: Add Transitions 

• Tap the white square between clips → choose a transition (e.g., fade, swipe, dissolve). 

• Adjust duration for smooth flow. 

Step 5: Add Music or Sound 

https://www.capcut.com/
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• Tap Audio → Sounds / Extracted / Voiceover. 

• You can import free tracks or record your voice directly. 

Step 6: Add Text or Captions 

• Tap Text → Add text to insert titles or subtitles. 

• Choose font, animation, and color. 

• Use Auto Captions to generate subtitles automatically (AI feature). 

Step 7: Add Filters & Effects 

• Tap Effects → Video effects / Body effects for visuals. 

• Use filters to match color tone across clips. 

Step 8: Add Stickers or Overlays 

• Go to Overlay → Add overlay to insert logos or images. 

• Use this for branding (e.g., channel name or logo). 

Step 9: Adjust Speed 

• Tap clip → Speed → Normal / Curve. 

• Use for slow-motion or time-lapse effects. 

Step 10: Export Your Video 

• Tap the Export arrow (top right). 

• Choose resolution (1080p or 4K). 

• Save or upload directly to YouTube, TikTok, or Instagram. 

 

Record your clips in horizontal for YouTube, vertical for Reels/Shorts. 

Keep intros under 5 seconds to retain audience attention. 

Add captions for accessibility. 

Use CapCut Templates (ready-made edits) to save time. 
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How to use adobe premiere pro 

Adobe Premiere Pro is a professional, timeline-based video editor used in film, TV, and YouTube 

production. 

Step 1: Create a New Project 

• Open Premiere Pro → New Project. 

• Name it and select your save location. 

• Choose your video resolution (e.g., 1920×1080, 30fps). 

Step 2: Import Footage 

• Go to File → Import (or drag and drop clips into the Project panel). 

• Organize clips in folders called bins (Video, Audio, Graphics). 

Step 3: Create a Sequence 

• Right-click a clip → New Sequence from Clip (automatically matches settings). 

• You can also choose manually: 1080p 30fps, 4K 60fps, etc. 

Step 4: Basic Editing 

• Drag clips to the timeline. 

• Use the Razor Tool (C) to cut. 

• Drag edges to trim clips. 

• Rearrange clips for storytelling order. 

Step 5: Add Music or Voice-over 

• Import your audio → place on the Audio Track. 

• Use the Audio Mixer to adjust levels or add fade-ins and fade-outs. 

Step 6: Add Transitions 

• Go to Effects → Video Transitions → Dissolve → Cross Dissolve. 

• Drag the effect between clips on the timeline. 
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Step 7: Add Titles and Graphics 

• Go to Window → Essential Graphics → New Title. 

• Customize fonts, animation, and colors. 

• Add lower-thirds or motion graphics templates. 

Step 8: Color Correction 

• Open Color Workspace → Lumetri Color Panel. 

• Adjust Exposure, Contrast, Highlights, Shadows. 

• Use presets (Cinematic, Warm, Cold tones). 

Step 9: Sound Editing 

• Go to Audio Track Mixer → adjust volume & EQ. 

• Remove noise via Effects → DeNoise or use Adobe Audition for cleaning. 

Step 10: Export 

• Go to File → Export → Media. 

• Format: H.264 (MP4) for YouTube/social media. 

• Choose Preset: YouTube 1080p Full HD. 

• Click Export. 

 

Save projects regularly (Ctrl + S). 

Use Adjustment Layers for consistent color grading. 

Label clips with colors for organization. 

Use shortcuts: Razor (C), Select (V), Ripple Delete (Shift + Delete). 

Export in 16:9 for YouTube, 9:16 for Reels. 

 

Free ai tools that help in video editing 
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Tool Use Website / Notes 

Runway ML AI video editor & background remover https://runwayml.com 

Pika Labs Generate videos from text https://pika.art 

Kapwing Auto-subtitles, trimming, resizing https://www.kapwing.com 

Veed.io AI subtitles, templates, noise removal https://www.veed.io 

Descript Edit video by editing text https://www.descript.com 

Animoto Auto-create video slideshows https://animoto.com 

Lumen5 Turns blog posts into videos https://lumen5.com 

Opus Clip AI tool that cuts long videos into short clips https://www.opus.pro 

Clipchamp Microsoft’s free online editor https://www.clipchamp.com 

Table 42: Free AI tools that help in video editing 

 

Video export formats and where to use them 

Format Use Case Platform 

MP4 (H.264) Universal video format YouTube, Facebook, Instagram 

MOV High-quality Apple format Editing or archiving 

AVI Uncompressed Broadcast TV 

MKV Multi-track videos Advanced archiving 

WEBM Web videos Websites, HTML5 

WMV Windows playback Presentations 

Table 43: Video export formats and where to use them 

 

BEST PRACTICES FOR VIDEO EDITORS 

1. Plan before editing: use a storyboard or script. 

https://runwayml.com/
https://pika.art/
https://www.kapwing.com/
https://www.veed.io/
https://www.descript.com/
https://animoto.com/
https://lumen5.com/
https://www.opus.pro/
https://www.clipchamp.com/
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2. Keep intros short: first 3 seconds matter most. 

3. Use subtitles: many people watch videos on mute. 

4. Use consistent fonts & branding. 

5. Cut out dead air and filler words. 

6. Keep transitions natural: avoid overusing effects. 

7. Use background music at -15 dB below voice. 

8. Color-correct all clips for uniform tone. 

9. Export in HD (1080p) or 4K. 

10. Always backup your project files. 

 

Resources for free video assets 

Asset Type Website 

Stock Footage Pexels Videos, Pixabay, Mixkit, Videvo 

Music & SFX YouTube Audio Library, Mixkit, FMA, Bensound 

Graphics & Templates Canva, MotionArray (free items), Videezy 

Table 44: Resources for free video assets 

 

Summary table 

Category Tool Purpose 

Basic Editing CapCut, InShot Social media clips 

Professional Editing Premiere Pro, DaVinci Resolve Film & YouTube 

AI Helpers Veed.io, Descript, Runway ML Auto-editing, subtitles 

Color Grading DaVinci Resolve Professional correction 

Audio Cleaning Audacity, Adobe Audition Voice clarity 

Free Media Pexels, Mixkit Stock video & audio 

Table 45: Summary table 



  
  

INNOVATE – EMPOWER - TRANSFORM 
  

123 | P a g e  

 

Editing = storytelling: every cut should serve a purpose. 

Choose the right tool for your goal and skill level. 

Learn both mobile (CapCut) and desktop (Premiere Pro) editing. 

Use AI tools to save time on captions, trimming, or background removal. 

Practice consistency in color, sound, and pacing. 

Always credit sources for any stock footage or music used. 

How to upload content on Youtube, Instagram, Tiktok, Facebook & X 

Youtube 

YouTube is a video-sharing platform where creators upload long-form and short-form videos to reach 

global audiences. It’s ideal for tutorials, music, sermons, vlogs, and educational content. 

 

How to Upload on YouTube (Desktop & Mobile) 

A. On Desktop 

1. Go to https://www.youtube.com. 

2. Sign in with your Gmail/YouTube account. 

3. Click the Create icon (📹 with a + sign) in the top-right corner. 

4. Select Upload video. 

5. Drag and drop your video file or click Select Files to upload. 

6. Fill in your video details: 

✓ Title: Keep it clear, short, and keyword-rich. 

✓ Description: Summarize content, add links, and hashtags. 

✓ Thumbnail: Upload a custom image (1280×720 px). 

✓ Tags: Add relevant keywords (e.g., #Motivation #Faith). 

✓ Playlist: Group related videos. 

7. Choose Audience: “Yes, it’s made for kids” or “No”. 

8. Add Subtitles, End screens, or Cards (optional). 

9. Choose Visibility: 

https://www.youtube.com/
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✓ Public – anyone can watch. 

✓ Unlisted – only with a link. 

✓ Private – only you. 

10. Click Publish or Schedule for later. 

 

B. On Mobile (YouTube App) 

1. Open the YouTube App. 

2. Tap the “+” icon → Upload a video. 

3. Choose a video from your phone gallery. 

4. Trim if needed → tap Next. 

5. Add Title, Description, Hashtags. 

6. Set Privacy (Public/Private). 

7. Tap Upload. 

 

Recommended Upload Settings 

Type Ratio Resolution Duration Format 

Long Video 16:9 1080p / 4K Up to 12 hrs MP4 

YouTube Shorts 9:16 1080p ≤ 60 sec MP4 

Table 46: Recommended Upload Settings 

 

Optimization 

• Add timestamps and chapters in the description. 

• Use a consistent thumbnail style for branding. 

• Post regularly (1–2 times/week). 

• Add end screens to promote your next video. 

• Respond to comments quickly. 

 



  
  

INNOVATE – EMPOWER - TRANSFORM 
  

125 | P a g e  

 

Instagram 

Instagram is a visual platform ideal for photos, Reels (short videos), carousels, and stories. It’s great for 

audience engagement and brand visibility. 

Upload on Instagram 

A. For Photos or Videos 

1. Open the Instagram app → Tap the “+” icon (bottom center). 

2. Choose your photo or video from your gallery. 

3. Apply filters or adjustments (optional). 

4. Tap Next. 

5. Write a caption (use hashtags like #Faith #Inspiration). 

6. Tag people and add a location if relevant. 

7. Choose Share to Feed, Story, or both. 

8. Tap Share. 

 

B. For Reels 

1. Tap Reels (icon) → Tap Camera. 

2. Record or upload a video (max 90 seconds). 

3. Add music, effects, or text overlays. 

4. Tap Next → Add caption, hashtags, and cover photo. 

5. Choose where to post (Feed or Reels tab). 

6. Tap Share. 

 

Recommended Upload Settings 

Type Ratio Duration Format 

Photo 1:1 or 4:5 N/A JPG / PNG 

Video / Reel 9:16 15–90 sec MP4 

Story 9:16 15 sec each MP4 
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Table 47: Recommended Upload Settings 

 

Optimization 

• Post high-quality, bright visuals. 

• Use 3–5 relevant hashtags. 

• Post during active hours (12–3 PM & 7–9 PM). 

• Add captions with call-to-actions (e.g., “Comment Amen 🙏”). 

• Engage with followers quickly after posting. 

Tiktok 

TikTok focuses on short, engaging videos (15–180 seconds) with sound, effects, and trends. It’s great for 

storytelling, tutorials, and motivational messages. 

 

Upload on TikTok 

1. Open the TikTok app → Tap the “+” button. 

2. Record directly or upload a pre-recorded clip. 

3. Tap Adjust clips to trim or rearrange. 

4. Add music, text, filters, or transitions. 

5. Tap Next. 

6. Add a caption, hashtags, and cover image. 

7. Choose who can view it (Public, Friends, or Private). 

8. Tap Post. 

 

 

Recommended Upload Settings 

Type Ratio Resolution Duration Format 

TikTok video 9:16 1080p 15–180 sec MP4 / MOV 

Table 48: Recommended Upload Settings 
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Optimization 

• Hook your viewer in the first 2 seconds. 

• Use trending sounds or hashtags. 

• Post 1–3 times daily for growth. 

• Add captions for clarity (many watch on mute). 

• Reply to comments with short video responses. 

 

Facebook 

Facebook supports all types of media: photos, videos, Reels, Stories, and live streams. Ideal for 

community engagement, announcements, and long-form discussions. 

Upload on Facebook (Page or Profile) 

A. From Mobile App 

1. Open Facebook → Tap “What’s on your mind?” 

2. Choose Photo/Video. 

3. Select from your gallery. 

4. Add caption, tags, hashtags, and location. 

5. Choose audience (Public/Friends). 

6. Tap Post. 

 

 

 

B. Uploading a Reel 

1. Tap Reels → Create reel. 

2. Record or upload video (≤ 90 sec). 

3. Add music, captions, or effects. 

4. Tap Next → Add caption and hashtags. 

5. Tap Share Reel. 
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Recommended Upload Settings 

Type Ratio Duration Format 

Photo 1:1 or 4:5 N/A JPG / PNG 

Video 16:9 or 9:16 Up to 240 min MP4 

Reel 9:16 Up to 90 sec MP4 

Story 9:16 15 sec MP4 

Table 49: Recommended Upload Settings 

Optimization 

• Post 1–2 times daily for engagement. 

• Use short, captioned videos (≤ 2 minutes). 

• Use Facebook Creator Studio to schedule posts. 

• Add call-to-actions (“Watch more”, “Join our live”). 

• Reply to comments to increase visibility. 

 

 X (Formerly Twitter) 

X is great for text-based updates, quick videos, links, and trending conversations. Ideal for building 

influence and real-time engagement. 

 

Upload on X 

A. To Post a Tweet with Media 

1. Open X App / Website → Tap Post (✏️). 

2. Type your message (limit: 280 characters). 

3. Tap the photo/video icon → Choose your media. 

4. Add hashtags and mentions (e.g., @User, #Motivation). 
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5. Tap Post. 

 

Recommended Upload Settings 

Type Ratio Resolution Duration Format 

Photo 1:1 or 16:9 1080p N/A JPG / PNG 

Video 16:9 or 9:16 1080p ≤ 2:20 min (free users) MP4 / MOV 

Table 50: Recommended Upload Settings 

 

Optimization 

• Keep posts short, clear, and engaging. 

• Use 1–2 hashtags max. 

• Tag relevant accounts to expand reach. 

• Post consistently (1–3 times daily). 

• Mix videos, photos, and threads. 

• Use X Analytics to monitor performance. 

 

Cross-platform best practices 

Aspect Guideline 

File Format MP4 for videos, JPG for photos 

Resolution Minimum 1080p for professional look 

Aspect Ratios YouTube: 16:9, TikTok/Instagram/Facebook: 9:16 

Captions/Subtitles Always add for accessibility 

Hashtags 3–5 relevant tags per post 

Thumbnails Bright, readable, branded 
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Timing Post when your audience is most active 

Analytics Check engagement & adjust content strategy 

Table 51: Cross-platform best practices 

 

AI tools to help with uploading & optimization 

Tool Use Website 

Canva Create thumbnails, social post templates https://www.canva.com 

Publer / Buffer Schedule posts across platforms https://www.publer.io 

ChatGPT Write captions, titles, hashtags https://chat.openai.com 

Opus Clip Create short clips from long videos https://www.opus.pro 

Pallyy Manage social media uploads visually https://www.pallyy.com 

Table 52: AI tools to help with uploading & optimization 

 

FINAL CHECKLIST BEFORE UPLOADING 

1. Video edited and reviewed 

2. Proper file format (MP4, 1080p) 

3. Clear title and caption 

4. Branded thumbnail 

5. Hashtags and tags added 

6. Subtitles added 

7. Correct aspect ratio (16:9 or 9:16) 

8. Good cover photo 

9. Checked visibility (Public/Private) 

10. Linked to other content (cross-promotion) 

 

How to blog using Blogger (on phone & laptop) 

https://www.canva.com/
https://www.publer.io/
https://chat.openai.com/
https://www.opus.pro/
https://www.pallyy.com/


  
  

INNOVATE – EMPOWER - TRANSFORM 
  

131 | P a g e  

 

What is Blogger? 

Blogger (also known as Blogspot) is a free blogging platform by Google that allows anyone to create and 

publish blogs easily. It’s ideal for personal journaling, news updates, educational posts, tutorials, church 

or business blogs, and inspirational content. 

Website: https://www.blogger.com 

 

Requirements before you start 

1. A Gmail account (you’ll use it to sign in). 

2. A Google Chrome browser (for best experience). 

3. Internet connection. 

4. Optional: a custom domain (e.g., www.yourname.com). 

5. Prepared content: title, article text, and images. 

How to create a blog on a laptop (desktop browser) 

Step 1: Sign in to Blogger 

1. Visit https://www.blogger.com. 

2. Click Sign in. 

3. Use your Google account to log in. 

Step 2: Create a New Blog 

1. Click the “+ New Blog” button. 

2. Enter your Blog Title (e.g., Faith Inspirations). 

3. Choose your Blog Address (URL) : example: faithinspirations.blogspot.com 

4. Select a Theme/Template from the list. 

5. Click Create Blog. 

Your blog is now live! 

Step 3: Write Your First Blog Post 

1. Click “+ New Post” on the left sidebar. 

2. Add a Post Title (e.g., “How to Stay Positive in Hard Times”). 

https://www.blogger.com/
http://www.yourname.com/
https://www.blogger.com/
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3. In the main editor box, type or paste your article. 

4. Use the toolbar to: 

✓ Bold / Italicize / Underline text. 

✓ Add Headings (H1, H2, and H3). 

✓ Insert links, images, or videos. 

✓ Add bullets or numbered lists. 

5. When done, click Preview to see how it looks. 

6. Click Publish to make it public. 

Step 4: Organize with Labels 

• On the right-hand menu, click Labels → Add categories like: 

✓ Faith, Motivation, Tech Tips, Recipes, etc. 

• This helps readers find related posts easily. 

Step 5: Customize Your Blog Appearance 

1. On the left menu, click Theme → choose or customize colors, fonts, and layout. 

2. Click Layout to rearrange sections like: 

✓ Header, Sidebar, Footer, About section, etc. 

3. Click Save arrangement when done. 

4. Add gadgets like: 

✓ Profile, Search Bar, Popular Posts, Labels, or Follow Button. 

Step 6: View Your Blog 

• Click the “View Blog” link (top left corner). 

• You’ll see your blog as visitors do. 

Step 7: Edit or Update Posts 

• From your dashboard, click Posts. 

• Choose the post → click Edit, make changes, and click Update. 

 

How to blog using blogger on a phone 

You can blog easily from your mobile browser (there’s no official Blogger app anymore). 
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Step 1: Open Blogger in Your Phone Browser 

1. Open Chrome or any mobile browser. 

2. Visit https://www.blogger.com. 

3. Log in with your Google account. 

Step 2: Switch to Desktop Mode (Recommended) 

• Tap the three dots (⋮) on your browser. 

• Select “Desktop site” for full editing features. 

Step 3: Create or Select Your Blog 

• Tap Create New Blog (if you don’t have one yet). 

• Add Title, Address (URL), and Theme → click Create Blog. 

Step 4: Create a Post 

1. Tap + New Post. 

2. Add Title and Content. 

3. Use formatting icons to style your text. 

4. Tap the image icon to upload from your phone gallery. 

5. Add Labels and location (optional). 

6. Tap Publish. 

Step 5: Manage Posts 

• Tap the menu (☰) → choose Posts to view, edit, or delete existing posts. 

• Tap Stats to check views and performance. 

Step 6: Share Your Blog Post 

After publishing, tap View Blog → Copy Link and share it on: 

• WhatsApp, Facebook, Instagram bio, X (Twitter), or LinkedIn. 

 

How to add images, videos & links 

https://www.blogger.com/


  
  

INNOVATE – EMPOWER - TRANSFORM 
  

134 | P a g e  

 

Action Steps 

Add Image Click 🖼️ icon → Upload → Choose from device or Google Photos. 

Add Video Click 🎥 icon → Upload video file or paste YouTube link. 

Add Link Highlight text → click 🔗 → paste your link → “Apply”. 

Table 53: AI tools to help with uploading & optimization 

Always compress images before uploading to make your blog load faster. 

 

How to monetize your blog 

Once you have quality content and steady visitors: 

1. Go to Earnings in the left sidebar. 

2. Click Connect to AdSense. 

3. Follow instructions to create or link your Google AdSense account. 

4. Once approved, Google will place ads automatically on your blog. 

Earn revenue when people view or click the ads. 

 

 

 

Managing settings 

Setting Purpose 

Basic Settings Change blog title, description, and privacy. 

Posts, Comments, & Sharing Manage who can comment. 

Email Set up post notifications. 

Language & Formatting Choose preferred language and time zone. 
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Search Preferences Add meta description and custom 404 page. 

Permissions Add authors or admin collaborators. 

Table 54: Managing settings 

 

How to track your blog’s performance 

• Go to Stats on the left panel. 

• View: 

✓ Post Views 

✓ Traffic Sources 

✓ Audience Location 

✓ Popular Posts 

Use Google Analytics for deeper insights: 

1. Go to https://analytics.google.com. 

2. Create a property → add tracking code to your Blogger Theme → Edit HTML. 

Blogging best practices 

Tip Why It Matters 

Post regularly (weekly/biweekly) Builds consistency & audience loyalty 

Use clear titles with keywords Boosts Google visibility 

Add images & subheadings Improves readability 

Always proofread Increases professionalism 

Link to related posts Keeps readers longer on your site 

Add a call-to-action (CTA) Encourages comments or subscriptions 

Use simple English Wider audience reach 

Backup your blog Prevents data loss 

Table 55: Blogging best practices 

 

https://analytics.google.com/
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Free ai tools that help with blogging 

AI Tool Use Website 

ChatGPT Draft blog posts, headlines, outlines https://chat.openai.com 

Canva Design blog images and banners https://www.canva.com 

Grammarly Proofread grammar & spelling https://www.grammarly.com 

QuillBot Paraphrasing & rewriting https://www.quillbot.com 

Pexels / Pixabay Free stock photos for posts https://www.pexels.com 

ChatGPT / Gemini / Jasper Generate SEO meta descriptions Various 

Table 56: Free AI tools that help with blogging 

 

How to improve SEO (Search Engine Optimization) 

1. Use keywords in your post title & first paragraph. 

2. Add alt text to every image. 

3. Write unique and helpful content. 

4. Add internal links to your other posts. 

5. Share your posts on social media for backlinks. 

6. Use search-friendly URLs (avoid numbers and random words). 

 

Final checklist before publishing 

• Title is short and keyword-rich 

• Introduction clearly states the topic 

• Subheadings used for structure 

• Spelling & grammar checked 

• Images optimized (compressed & with alt text) 

• Labels and meta description added 

• Post previewed 

• Links working correctly 

• Published and shared on social media 

https://chat.openai.com/
https://www.canva.com/
https://www.grammarly.com/
https://www.quillbot.com/
https://www.pexels.com/
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Branding, Marketing, and Monetization 

What Is Branding? 

Branding is the process of creating a unique identity for a person, business, product, or organization that 

makes it easily recognizable and memorable. It goes beyond a logo: it’s about the feeling, perception, and 

trust people have when they hear your name. 

 

Why Branding Matters 

Reason Explanation 

Recognition People easily identify your work or products. 

Trust & Credibility A consistent image builds confidence. 

Emotional Connection Branding creates feelings that connect with people. 

Professionalism Makes your content, church, or business look legitimate. 

Differentiation Helps you stand out from others in the same field. 

Marketing Advantage A strong brand makes promotion easier and more effective. 

Table 57: Why Branding Matters 

 

Elements of a Brand 

Every strong brand is built from these key elements: 

Element Description 

Brand Name The official name (e.g., Christian Growth Centre Church). 

Logo A visual symbol representing your identity. 
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Tagline/Slogan A short, memorable phrase that sums up your mission (e.g., “Grow in Faith, Live 

in Love”). 

Color Palette A consistent set of colors used across materials. 

Typography Specific fonts that represent your style and tone. 

Voice & Tone The way you communicate : friendly, formal, spiritual, humorous, etc. 

Imagery Style Type of photos or visuals you use : bright, minimalist, natural, etc. 

Mission & 

Values 

What your brand stands for and why it exists. 

Audience 

Identity 

The group of people your message targets. 

Table 58: Elements of a Brand 

 

How to Develop a Brand 

Step 1: Define Your Purpose 

Ask: 

• Why do I exist as a brand? 

• What problem am I solving? 

• What impact do I want to create? 

        Example: 

"To use digital media to spread the Word of God and inspire personal growth." 

Step 2: Identify Your Target Audience 

Know who you are talking to: 

• Their age, interests, location, and needs. 

• Example: Young Christians aged 18–35 who want daily encouragement online. 

This helps you shape your message and design. 
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Step 3: Choose a Brand Name 

Tips: 

• Make it short and memorable. 

• Avoid names that are hard to spell or pronounce. 

• It should reflect your mission or product. 

 Example: 

• Business: DamaDee Technologies 

• Ministry: Faith Connect 

• Personal Brand: Winniefred Inspires 

Step 4: Design Your Visual Identity 

This includes your logo, colors, and fonts. 

Brand 

Element 

Guidelines 

Logo Use Canva or LogoMaker to create a simple and clear design. It should look good in 

color and black & white. 

Colors Choose 2–3 main colors that reflect your message (e.g., blue for trust, gold for 

excellence, green for growth). 

Fonts Use consistent fonts for headings and text: don’t mix too many styles. 

Imagery Use photos or graphics that reflect your brand’s tone. Avoid low-quality or unrelated 

images. 

Table 59: Designing Your Visual Identity 

 

Step 5: Develop Your Brand Voice & Messaging 

Decide how your brand “speaks” to people. 

Type Example 
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Formal & Professional For tech or education companies. 

Friendly & Conversational For influencers and community projects. 

Inspiring & Motivational For churches or self-improvement brands. 

Table 60: Develop Your Brand Voice & Messaging 

Example Brand Message: 

“We empower individuals through digital skills and faith-based motivation.” 

 

Step 6: Create Brand Materials 

• Profile pictures, banners, letterheads, flyers, and business cards. 

• Keep color, font, and logo consistent. 

• Use templates from Canva or Figma for design. 

Step 7: Build Your Online Presence 

Create consistent profiles across platforms: 

• Website or Blog (e.g., Blogger, WordPress) 

• Social Media: Facebook, Instagram, TikTok, YouTube, X 

• Email Branding: Use your name or domain (e.g., info@yourbrand.com) 

Use the same logo, bio, and brand colors across all platforms. 

Step 8: Stay Consistent 

Consistency = Recognition + Trust. 

Make sure your: 

• Visuals look the same across platforms. 

• Voice (style of speaking/writing) stays constant. 

• Posting schedule is regular (e.g., every Monday or Thursday). 

Step 9: Engage with Your Audience 

mailto:info@yourbrand.com
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Reply to comments, ask questions, and build community. 

Branding is not just visuals, it’s about relationships. 

Step 10: Review & Adjust 

Over time, measure how people respond to your brand. 

• Use analytics (e.g., Facebook Insights, Google Analytics). 

• Ask for feedback. 

• Refine your message, design, or strategy as needed. 

 

Types of Branding 

Type Purpose Example 

Personal Branding Build identity around a person Influencers, pastors, coaches 

Corporate Branding Represents a company Damadee Technologies 

Product Branding For specific items Coca-Cola, Infinix 

Service Branding For a service offered Safaricom Mpesa 

Online/Digital Branding For social media or websites YouTube channels, blogs 

Cause/Church Branding For ministries or social impact Christian Growth Centre Church 

Table 61: Types of Branding 

 

Free AI & Online Tools for Branding 

Tool Use Website 

Canva Logo design, brand kit, social posts https://www.canva.com 

Looka AI logo generator https://looka.com 

Hatchful by Shopify Free logo maker https://hatchful.shopify.com 

https://www.canva.com/
https://looka.com/
https://hatchful.shopify.com/
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Coolors Generate color palettes https://coolors.co 

Fontjoy Font pairing generator https://fontjoy.com 

ChatGPT Write bios, taglines, mission statements https://chat.openai.com 

Remove.bg Remove background from logos/images https://remove.bg 

Brandmark.io AI logo and brand identity kit https://brandmark.io 

Table 62: Free AI & Online Tools for Branding 

 

Branding Across Platforms 

Platform Key Branding Tips 

YouTube Use a consistent intro video, profile photo, and channel art. Add your logo watermark. 

Instagram Maintain a consistent color scheme. Create a bio that reflects your mission. 

Facebook Use professional cover and profile images. Keep tone friendly and responsive. 

TikTok Use consistent themes or filters. Add a short brand tagline in your bio. 

X (Twitter) Keep your handle simple and recognizable. Post in your brand voice. 

Blog/Website Include logo, consistent fonts, and a clear “About” section. 

Table 63: Branding Across Platforms 

Measuring Brand Success 

Check if your brand is growing using: 

• Engagement: likes, shares, comments. 

• Reach: how many people see your posts. 

• Traffic: visits to your site or pages. 

• Conversion: how many people take action (buy, follow, subscribe). 

Use tools like: 

• Google Analytics 

• Facebook Page Insights 

https://coolors.co/
https://fontjoy.com/
https://chat.openai.com/
https://remove.bg/
https://brandmark.io/
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• Instagram Analytics 

 

Common Branding Mistakes to Avoid 

• Changing colors, logos, or names too often 

• Copying other brands 

• Using too many fonts or colors 

• Inconsistent posting or messaging 

• Ignoring audience feedback 

• Poor-quality visuals 

 

Key Branding Guidelines 

What to Do 

Define your brand purpose and audience 

Choose a name and create a logo 

Select color palette and fonts 

Develop your brand voice and tagline 

Create visual templates and materials 

Set up consistent online profiles 

Post content regularly and engage your audience 

Monitor results and adjust strategy 

Table 64: Key Branding Guidelines 

 

The 3 Cs of Branding 

1. Clarity – Know who you are and what you stand for. 

2. Consistency – Be the same everywhere, every time. 
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3. Connection – Build emotional relationships with your audience. 

 

How to create a Logo and a Thumbnail in Canva 

Practical for both desktop and mobile, plus sizing, export tips, branding best practices and a final 

checklist so your assets look professional and consistent. 

 

Before you open Canva 

1. Decide the purpose (logo for website/profile, thumbnail for YouTube/Reel/etc.). 

2. Gather: brand name, tagline (optional), preferred colors (hex codes), font choices, and any 

icon/imagery ideas. 

3. Think where the asset will be used (profile avatar, YouTube 1280×720 cover, Instagram 

thumbnail, etc.). 

4. Have reference examples you like (mood board). 

 

 

 

 

Create a Logo in Canva 

Recommended sizes 

• Square logo (default): 500 × 500 px or 1000 × 1000 px (vector-like quality). 

• App/Avatar: 400 × 400 px. 

Design at higher resolution (1000–2000 px) and downscale for sharpness. 

Desktop step-by-step 

1. Sign in at canva.com → Create a design → choose Custom size and enter e.g. 1000 x 1000 px. 

2. In the left panel, click Templates and type “logo” to browse templates OR start blank. 

3. Add your brand name with Text → Add a heading. 
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✓ Use 1–2 fonts max (one for logo mark, one for tagline optional). 

4. Add an icon: Elements → Search for icons (type: “cross”, “book”, “tech”, etc.). Use simple, 

scalable icons. 

5. Arrange layout: icon + name (icon left or above), leave generous spacing. 

6. Apply brand colors: click element → color swatch → paste hex code. 

7. Align everything (select elements → Position → Center / Middle) and check the balance. 

8. Optional: add a simple shape behind the icon for contrast (circle/rounded square). 

9. Preview at small sizes (zoom out to see how it looks as an avatar). 

10. Save versions: File → Make a copy and create variations (full logo, stacked, icon only). 

Mobile (Canva app) steps 

1. Open Canva app → + → Custom size → enter square px. 

2. Use Templates → Logo or start blank. 

3. Tap elements, text, and color controls: same workflow as desktop. 

4. Use two-finger zoom to check small size readability. 

Exporting & formats 

• For web/social: PNG (lossless). 

• If you need background removed: PNG with transparent background (Canva Pro or use 

Remove.bg). 

• For print: PDF Print or SVG (Pro) if you need vector. 

• Export multiple sizes: e.g., 1000px, 500px, 200px to keep on hand. 

Logo design  

• Keep it simple and legible at thumbnail size. 

• Avoid fine details that disappear when small. 

• Test on light & dark backgrounds. Save a white and dark version. 

• Create an icon-only variant for avatars. 

• Use the Brand Kit (Canva Pro) to store palette and fonts for consistency. 

 

Create a Thumbnail in Canva (YouTube / Social) 

Recommended sizes 
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• YouTube thumbnail: 1280 × 720 px (16:9) 

• Instagram post thumbnail: 1080 × 1080 px (1:1) 

• TikTok / Reels cover: 1080 × 1920 px (9:16) : note that some platforms may crop on display 

Desktop step-by-step (YouTube example) 

1. Create a design → Custom size → 1280 x 720 px. 

2. Use Templates → YouTube Thumbnail and pick a layout you like (fast start) OR start from a 

blank canvas. 

3. Upload the frame/screenshot from your video (Uploads → Upload media). Place as background 

or an image area. 

4. Add a bold headline (6–8 words max). Use large, readable font (sans-serif or display). 

✓ Contrast is crucial: light text on dark overlay or vice versa. 

5. Add a subtle overlay to ensure text legibility: 

✓ Elements → Square → stretch full → color black → set Transparency to ~30–45% under 

the overlay. 

6. Add an eye-catching element: subject close-up face, an icon, or a border. Use stroke on text to 

improve readability. 

7. Use consistent brand colors and fonts (same family as your logo). 

8. Make a small logo/brand mark in a corner for recognition. 

9. Check composition with the Rule of Thirds Grid (View → Show grid) for focal points. 

10. Export as PNG (best quality) or JPG (smaller size). For thumbnails keep file < 2MB for 

YouTube. 

 

Mobile (Canva app) steps 

1. Open Canva app → choose YouTube Thumbnail template or custom 1280×720 px. 

2. Upload image, tap to crop, add text, overlays & stickers. 

3. Use pinch zoom and preview to make sure text is readable on small screens. 

Thumbnail design tips 

• Title text must be readable at small sizes: test by zooming out. 

• Faces + strong expression + large text = high click-through. 

• Contrast & simplicity beat clutter. 

• Keep a consistent thumbnail style across your channel for branding. 

• Create templates in Canva: duplicate and swap images/text for fast batch creation. 
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Branding & Consistency: Use Canva Features 

• Brand Kit (Pro): store colors, fonts, logos. 

• Templates: create a master thumbnail template and duplicate for new videos. 

• Folders: organize assets → Logos, Thumbnails, Exports. 

• Magic Resize (Pro): quickly create different aspect ratios for other platforms. 

• Styles: save color/font combos to apply quickly. 

 

Accessibility & SEO tips 

• Add alt text when you upload images to websites (describe the logo/thumbnail). 

• For thumbnails, include the target keyword in the file name, e.g., how-to-pray_thumbnail.png. 

• Use high-contrast colors for readability and for viewers with low vision. 

 

Export settings & platform specifics 

Asset Format Settings 

Logo (web) PNG Transparent background (if needed), 500–1000 px 

Logo (print) PDF/SVG High-res/vector (use SVG or PDF Print) 

Thumbnail (YouTube) PNG or JPG 1280×720 px, <2MB, sRGB color 

Thumbnail (Instagram) JPG/PNG 1080×1080 px 

Thumbnail (TikTok cover) PNG 1080×1920 px (mind cropping) 

Table 65: Export settings & platform specifics 

 

File naming, versioning & storage (best practice) 

• Name clearly: brandname_logo_primary_1000px.png, video-title_thumbnail_v1.png. 

• Keep versions: _v1, _v2 with date. 
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• Store originals in a folder (Google Drive / Dropbox) and exports in a share folder. 

 

Troubleshooting 

• Text blurry when small → increase font size, reduce word count. 

• Icon too detailed → simplify shape, remove tiny elements. 

• Background image hides text → add darker overlay or outline text. 

• Need transparent logo but don’t have Pro → export PNG and use remove.bg (free online) to 

remove background. 

 

Final checklist before publishing 

Logo: 

• Readable at small size (avatar). 

• Versions: full, stacked, icon-only. 

• Exported PNG (and SVG/PDF if needed). 

• Saved brand colors & fonts in Brand Kit (if available). 

Thumbnail: 

• Correct size/aspect ratio for platform. 

• Text is large & readable. 

• High contrast between text and background. 

• Branded (logo/consistent style). 

• File optimized (size < platform limit) and exported PNG/JPG. 

 

Marketing and SEO 

What Is Marketing? 

Marketing is the process of promoting, communicating, and delivering value to customers or audiences. 

It involves identifying their needs, creating valuable content or products, and ensuring they reach the right 

people through the right channels. 
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Goals of Marketing 

• Increase Awareness – Let people know about your brand, product, or message. 

• Generate Leads or Sales – Encourage people to buy, subscribe, or donate. 

• Build Trust & Loyalty – Keep your audience coming back. 

• Engage & Educate – Provide useful, inspiring, or entertaining information. 

• Create Community – Build followers or supporters who connect with your mission. 

 

The Marketing Process 

Step Description 

Market Research Understand your audience: their age, location, interests, and challenges. 

Identify Your Target 

Audience 

Choose who you are talking to (e.g., students, youth, entrepreneurs, 

church members). 

Develop Your Message Craft a clear value statement: why your content or product matters. 

Choose Channels Decide where to market : social media, blog, YouTube, email, etc. 

Create & Share Content Publish posts, videos, ads, or stories consistently. 

Measure & Improve Track performance using analytics tools and adjust strategy. 

Table 66: The Marketing Process 

 

Types of Marketing 

Type Description Examples 

Digital Marketing Using the internet to promote 

products/services. 

Websites, social media, SEO, 

email marketing 

Content 

Marketing 

Creating valuable content to attract and 

educate. 

Blogs, YouTube videos, 

infographics 



  
  

INNOVATE – EMPOWER - TRANSFORM 
  

150 | P a g e  

 

Social Media 

Marketing 

Promoting through platforms like Facebook, 

Instagram, TikTok, X. 

Posts, reels, hashtags, ads 

Email Marketing Sending messages directly to subscribers. Newsletters, promotions 

Affiliate 

Marketing 

Earning commission by promoting others’ 

products. 

Amazon affiliates, referral links 

Influencer 

Marketing 

Partnering with creators to reach new 

audiences. 

Brand collaborations 

Video Marketing Using video content to attract and engage. YouTube, Shorts, Reels 

SEO Marketing Optimizing content for search engines. Keyword usage, backlinks 

Paid Marketing Using ads to reach specific people. Facebook Ads, Google Ads 

Table 67: Types of Marketing 

 

The 4 Ps of Marketing 

P Meaning Example 

Product What you are offering (content, service, or product). Bible study app, coaching, courses 

Price What it costs (or what value people give: even if 

free). 

Subscription, donation, free 

resource 

Place Where people find it. YouTube, website, app store 

Promotion How you tell people about it. Ads, posts, word of mouth 

Table 68: The 4 Ps of Marketing 

 

Create a Marketing Plan 

Step 1: Define Your Goal 

What do you want? 

Examples: 
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• Grow YouTube subscribers by 1,000 

• Sell 50 e-books 

• Get 500 new Instagram followers 

Step 2: Understand Your Audience 

• Who are they (age, gender, profession)? 

• What do they need or want? 

• Where do they spend time online? 

Step 3: Research Competitors 

Look at others in your niche: what are they doing right? How can you do it better? 

Step 4: Choose Marketing Channels 

Pick platforms where your audience is most active (Facebook, YouTube, TikTok, Email, etc.). 

Step 5: Create Valuable Content 

Plan weekly content based on your goal: 

• Blog posts 

• Reels or Shorts 

• YouTube tutorials 

• Inspirational quotes 

Step 6: Engage With Your Audience 

Reply to comments, messages, and emails. 

Ask questions and create polls. 

Step 7: Track Results 

Use analytics tools (YouTube Analytics, Facebook Insights, Google Analytics). 

Measure engagement, traffic, and conversions. 

Step 8: Improve and Repeat 
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Adjust your strategy monthly based on performance. 

 

Marketing Tools & AI Platforms 

Tool Use Website 

Canva Design posters, flyers, ads https://www.canva.com 

ChatGPT Write captions, marketing emails, ad copy https://chat.openai.com 

Meta Business Suite Manage Facebook & Instagram posts https://business.facebook.com 

Google Analytics Track website/blog traffic https://analytics.google.com 

Mailchimp Send email campaigns https://mailchimp.com 

Buffer / Later Schedule social media posts https://buffer.com 

CapCut / InVideo / Pika Edit marketing videos https://www.capcut.com 

Lumen5 / Synthesia AI video creation from text https://www.lumen5.com 

Table 69: Marketing Tools & AI Platforms 

 

What is SEO (Search Engine Optimization)? 

SEO (Search Engine Optimization) is the process of making your website, blog, or content more visible 

on search engines (like Google, Bing, or YouTube). 

How SEO Works 

Search engines (like Google) use algorithms to decide which pages appear first in results based on: 

• Keywords used in the title and text 

• Page loading speed 

• Mobile-friendliness 

• Backlinks (links from other sites to yours) 

• Content quality and freshness 

https://www.canva.com/
https://chat.openai.com/
https://business.facebook.com/
https://analytics.google.com/
https://mailchimp.com/
https://buffer.com/
https://www.capcut.com/
https://www.lumen5.com/
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Step-by-Step SEO Process 

Step 1: Keyword Research 

Find the words people search for about your topic. 

Tools: 

• Google Keyword Planner 

• Ubersuggest 

• Ahrefs (Free version) 

• ChatGPT (Ask: “Give me SEO keywords for [topic]”) 

Example: 

If your topic is Faith Motivation, keywords might include: 

• “daily bible encouragement” 

• “Christian motivation quotes” 

• “inspirational devotion” 

 

Step 2: Optimize Your Content 

Include your main keyword in: 

• The title 

• The first paragraph 

• Subheadings (H2, H3) 

• Image alt text 

• URL (example: yoursite.com/christian-motivation-tips) 

Step 3: Write Quality Content 

Google rewards: 

✓ Useful and original content  

✓ Clear structure (headings, bullet points) 
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✓ Internal links to your other pages 

✓ External links to credible sources 

Step 4: Optimize Images 

• Compress images (use TinyPNG). 

• Add alt text describing the image. 

• Rename image files before uploading (e.g., christian-blog-banner.png). 

Step 5: Improve Website Speed 

Use: 

• Lightweight themes 

• Minimal plugins 

• Google PageSpeed Insights to test load time 

Step 6: Get Backlinks 

Encourage other websites to link to yours: 

• Guest post on other blogs 

• Share valuable resources people want to link to 

• Collaborate with creators 

 Step 7: Submit to Google 

Use Google Search Console to submit your site and sitemap: 

• https://search.google.com/search-console 

This helps Google index your content faster. 

 Step 8: Track & Update 

SEO is ongoing. 

Check: 

• Keyword ranking 

https://search.google.com/search-console
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• Traffic (in Google Analytics) 

• Update old posts every few months 

 

Types of SEO 

Type Meaning Example 

On-Page SEO Optimization within your content Keywords, images, headings 

Off-Page SEO External actions that build reputation Backlinks, guest posts 

Technical SEO Behind-the-scenes improvements Site speed, mobile optimization 

Local SEO Targeting local audience “Best coffee shop in Nairobi” 

Video SEO Optimizing videos for YouTube Titles, tags, captions 

Table 70: Types of SEO 

 

 

SEO Tools and Free AI Platforms 

Tool Purpose Website 

Google Keyword 

Planner 

Find keywords https://ads.google.com/home/tools/keyword-

planner 

Ubersuggest Keyword + competitor 

analysis 

https://ubersuggest.com 

Yoast SEO 

(WordPress plugin) 

Optimize posts easily https://yoast.com 

Rank Math SEO scoring for 

WordPress 

https://rankmath.com 

ChatGPT Generate SEO titles, meta 

descriptions 

https://chat.openai.com 

https://ads.google.com/home/tools/keyword-planner
https://ads.google.com/home/tools/keyword-planner
https://ubersuggest.com/
https://yoast.com/
https://rankmath.com/
https://chat.openai.com/
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Canva Create optimized images 

with alt text 

https://www.canva.com 

TinyPNG Compress images https://tinypng.com 

Google Search 

Console 

Monitor site performance https://search.google.com/search-console 

Table 71: SEO Tools and Free AI Platforms 

 

SEO-Friendly Content 

✓ Use short paragraphs (2–4 lines). 

✓ Add headings (H2, H3) for structure. 

✓ Include lists, bullets, and visuals. 

✓ Link to your own posts (internal linking). 

✓ End with a call-to-action (CTA). 

✓ Update older posts regularly. 

✓ Ensure your site is mobile-friendly. 

✓ Add meta descriptions (short 150-character summaries). 

 

SEO & Marketing Connection 

Marketing brings traffic, SEO helps that traffic find you organically. 

Marketing SEO 

Pushes your message to people Pulls people searching for your message 

Short-term impact (ads, campaigns) Long-term impact (ranking, authority) 

Social & emotional connection Search & informational relevance 

Focus on visibility Focus on discoverability 

Table 72: SEO & Marketing Connection 

Together, they build strong digital visibility and brand growth. 

https://www.canva.com/
https://tinypng.com/
https://search.google.com/search-console
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Digital Safety, Ethics, and Copyright 

What Is Digital Safety? 

Digital Safety refers to the responsible and secure use of technology, internet, and online platforms to 

protect personal information, devices, and reputation from harm, theft, or misuse. 

 

Importance of Digital Safety 

• Prevent identity theft and fraud 

• Protect personal data (passwords, photos, contacts) 

• Avoid cyberbullying and online harassment 

• Stay safe from malware, viruses, and hacking 

• Maintain a positive digital reputation 

• Ensure ethical and legal behavior online 

 

 

Key Areas of Digital Safety 

Area Description Examples 

Password Safety Using strong and unique passwords for 

each account 

Avoid using “123456” or your 

name 

Privacy Protection Managing what you share online Limiting personal info on social 

media 

Data Security Safeguarding files and information Using two-factor authentication 

Cyberbullying 

Prevention 

Respectful communication Blocking or reporting bullies 

Device Protection Keeping your gadgets secure Using antivirus, updating 

software 
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Safe Browsing Avoiding harmful or fake sites Checking for HTTPS before 

entering data 

Table 73: Key Areas of Digital Safety 

 

Staying Safe Online 

1. Use Strong Passwords 

✓ At least 12 characters (mix letters, numbers, symbols) 

✓ Use password managers like Bitwarden or LastPass 

2. Enable Two-Factor Authentication (2FA) 

✓ Add an extra security step to logins (via SMS or app) 

3. Think Before You Click 

✓ Avoid suspicious links, pop-ups, or email attachments 

4. Update Software Regularly 

✓ Updates fix security holes and improve performance 

5. Use Secure Wi-Fi 

✓ Avoid logging in to sensitive accounts on public Wi-Fi 

6. Adjust Privacy Settings 

✓ On Facebook, Instagram, TikTok : limit what’s public 

7. Backup Data 

✓ Store important files on cloud or external drives 

8. Be Kind Online 

✓ Follow netiquette : no hate speech or cyberbullying 

9. Fact-Check Information 

✓ Verify news before sharing to stop misinformation 

10. Log Out When Sharing Devices 

✓ Especially on shared computers or phones 

 

Understanding Digital Ethics 

Digital Ethics means doing what is right when using technology. 

It’s about honesty, respect, responsibility, and fairness in the digital world. 

 

Core Principles of Digital Ethics 
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Principle Meaning Example 

Integrity Be truthful in online interactions Don’t spread fake news 

Respect Value others’ rights and privacy Don’t share private info without consent 

Responsibility Use technology wisely Avoid plagiarism or harmful content 

Fairness Treat everyone equally Give credit to content creators 

Accountability Take responsibility for actions Apologize or correct mistakes publicly 

Table 74: Core Principles of Digital Ethics 

 

Unethical Online Behaviors 

Avoid: 

• Cyberbullying or trolling 

• Spreading misinformation 

• Using fake identities 

• Copying others’ work without permission 

• Accessing or sharing explicit or illegal content 

• Pirating music, software, or videos 

 

Examples of Ethical Digital Behavior 

1. Respecting copyright and giving credit 

2. Using reliable sources when posting information 

3. Avoiding sharing violent, hateful, or misleading content 

4. Using AI tools responsibly (no fake identities, no bias) 

5. Citing references in blogs or academic posts 

 

What Is Copyright? 
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Copyright is a legal protection given to creators of original works (text, music, images, videos, software, 

etc.) so others cannot use or copy them without permission. 

 

Works Protected by Copyright 

• Books, blogs, and articles 

• Music, podcasts, and audio recordings 

• Photos, paintings, and designs 

• Films and videos 

• Computer programs and websites 

• Artistic and literary works 

 

 

 

 

 

 

Rights of the Copyright Holder 

Right Meaning 

Reproduction Right To make copies of the work 

Distribution Right To share or sell copies 

Derivative Works To modify or remix the work 

Public Display Right To show the work publicly 

Performance Right To perform or play it publicly 

Table 75: Rights of the Copyright Holder 
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What You Can and Can’t Do 

You Can You Can’t 

Share content with proper credit (if permitted) Copy entire articles or videos without permission 

Use free stock images from trusted sites Download music or movies illegally 

Quote short passages under “fair use” Claim others’ work as your own 

Remix content if it’s under Creative Commons Remove watermarks or edit logos 

Use AI to create new content ethically Replicate copyrighted characters or stories 

Table 76: What You Can and Can’t Do 

 

 

 

 

 

Understanding Creative Commons (CC) 

Creative Commons licenses allow creators to share their work freely but with specific conditions. 

License Type Symbol Meaning 

CC BY 👤 You can use it if you give credit 

CC BY-SA 🔁 You can share or adapt, must credit and share alike 

CC BY-ND 🚫 You can share but not change 

CC BY-NC 💵❌ You can use for non-commercial purposes only 

CC0 🌐 Public domain – free to use with no restrictions 

Table 77: Understanding Creative Commons (CC) 
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Example: 

A photo on Unsplash (CC0) can be used in YouTube thumbnails freely. 

A song under CC BY-NC can be used for a podcast if it’s not monetized. 

 

How to Use Copyrighted Material Legally 

1. Ask for Permission – Contact the creator or copyright owner. 

2. Use Royalty-Free or CC Licensed Content – from safe sources. 

3. Credit the Source – Include the name, title, and link. 

4. Use Fair Use Judiciously – Only small excerpts for commentary, news, or education. 

5. Avoid Commercial Use Without a License. 

 

 

 

 

 

Free & Safe Resources for Creators 

Category Platform Website 

Free Photos Unsplash https://unsplash.com 

Free Videos Pexels Video https://pexels.com/videos 

Free Audio Free Music Archive https://freemusicarchive.org  

Sound Effects Mixkit https://mixkit.co 

AI Image Generator Leonardo AI https://leonardo.ai 

AI Video Generator Pika / Lumen5 https://pika.art, https://lumen5.com 

AI Writing Tool ChatGPT https://chat.openai.com 

Table 78: Free & Safe Resources for Creators 

https://unsplash.com/
https://pexels.com/videos
https://freemusicarchive.org/
https://mixkit.co/
https://leonardo.ai/
https://pika.art/
https://lumen5.com/
https://chat.openai.com/
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AI, Ethics, and Copyright 

When using AI tools: 

• Don’t claim AI-generated work as “fully original” if it uses public data. 

• Avoid generating content that imitates living artists or brands. 

• Always review AI outputs for factual accuracy and bias. 

• If you use AI-generated media, mention it clearly (e.g., “Image generated using Leonardo AI”). 

Tools for Protecting Your Content 

Tool Purpose Website 

Google Alerts Track if someone copies your 

content 

https://alerts.google.com 

Pixsy Detect stolen photos online https://pixsy.com 

Canva Watermark Protect graphics or logos https://www.canva.com 

Copyscape / Grammarly Plagiarism 

Checker 

Check originality of text https://www.copyscape.com 

YouTube Content ID Detect reuploads of your videos Built into YouTube Studio 

Table 79: Tools for Protecting Your Content 

 

Real-World Scenarios 

Situation Right Action 

You find a nice song online for your video Check if it’s copyright-free or CC licensed 

Someone reposts your photo without credit Politely ask for credit or report if needed 

You see an AI image that looks like a celebrity Avoid posting if it violates privacy 

You want to quote a blog post Use short sections with full attribution 

Table 80: Real-World Scenarios 

https://alerts.google.com/
https://pixsy.com/
https://www.canva.com/
https://www.copyscape.com/
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Safe & Ethical Content Creation 

1. Plan your content topic (Ensure it’s original) 

2. Research responsibly (Use credible sources) 

3. Create or use media legally (Own, AI-generate, or download from CC sites) 

4. Edit carefully (Avoid offensive or misleading info) 

5. Credit sources (Even free ones) 

6. Review before posting (Check facts, tone, and permissions) 

7. Engage respectfully (Follow digital ethics) 

8. Monitor and protect your work (Use Google Alerts) 

 

 

 

 

 

 

Freelancing, Entrepreneurship & Future Opportunities 

What Is Freelancing? 

Freelancing is when you use your skills to work independently for clients, usually online, instead of being 

employed by one company. 

A freelancer is a self-employed person who offers services like writing, design, marketing, or tech support 

to clients on a project basis. 

 

Why Freelancing Is Important 

• Offers flexibility: work anytime, anywhere. 

• No degree barrier: skill matters more than certificates. 

• You can earn global income in dollars or euros. 
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• Builds a personal brand and portfolio. 

• Encourages innovation and self-discipline. 

 

Popular Freelance Skills 

Category Skills/Services 

Writing & Translation Copywriting, blogging, proofreading, transcription 

Design Graphic design, logo creation, video editing, UI/UX 

Tech Web development, mobile apps, coding, cybersecurity 

Marketing SEO, social media marketing, email campaigns 

Business Virtual assistance, bookkeeping, project management 

Education Online tutoring, course design, e-learning 

Creative Voice-over, photography, animation, podcast editing 

Table 81: Popular Freelance Skills 

 

Top Freelance Platforms 

Platform Focus Area Website 

Upwork General freelancing https://www.upwork.com 

Fiverr Creative services https://www.fiverr.com 

Freelancer.com Global project marketplace https://www.freelancer.com 

Toptal Professional developers/designers https://www.toptal.com 

PeoplePerHour Business & creative work https://www.peopleperhour.com 

Guru Business & admin support https://www.guru.com 

Workana Latin American and African freelancers https://www.workana.com 

Table 82: Top Freelance Platforms 

https://www.upwork.com/
https://www.fiverr.com/
https://www.freelancer.com/
https://www.toptal.com/
https://www.peopleperhour.com/
https://www.guru.com/
https://www.workana.com/
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Start Freelancing 

Step 1: Identify Your Skills 

List what you can do: writing, design, coding, admin, or social media. 

Use free learning platforms to improve (e.g., YouTube, Coursera, Google Digital Skills). 

Step 2: Build a Portfolio 

Create sample work to show your skills: use Canva, Behance, or a simple Google Drive folder. 

Step 3: Choose a Freelance Platform 

Sign up on one or two platforms (e.g., Fiverr, Upwork). 

Step 4: Create an Attractive Profile 

• Add a clear professional photo. 

• Write a short, strong bio (what you offer + your experience). 

• Include keywords relevant to your skills. 

Step 5: Create Gigs or Apply for Jobs 

On Fiverr → Create “Gigs” (services). 

On Upwork → Apply to projects using a short proposal. 

Step 6: Communicate Professionally 

Be polite, clear, and prompt in replying to clients. 

Step 7: Deliver Quality Work 

Submit before the deadline. Always overdeliver. 

Step 8: Request Reviews 

Good client ratings build your reputation and attract more work. 
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Step 9: Manage Payments 

Use Payoneer, Wise, or PayPal to receive funds securely. 

 

Free Tools for Freelancers 

Purpose Tool Website 

Portfolio Creation Canva / Behance https://canva.com, https://behance.net 

Project Management Trello / Notion https://trello.com, https://notion.so 

Contracts & Invoicing Bonsai / AND.CO https://www.hellobonsai.com 

Time Tracking Clockify https://clockify.me 

Communication Zoom / Slack https://zoom.us 

File Sharing Google Drive / Dropbox https://drive.google.com 

Table 83: Free Tools for Freelancers 

 

What Is Entrepreneurship? 

Entrepreneurship is the process of starting and running your own business or project to solve problems 

and create value for others: while earning profit or impact. Entrepreneurs see problems as opportunities. 

Characteristics of an Entrepreneur 

Trait Description 

Creativity Comes up with new ideas 

Risk-taking Willing to try new ventures 

Resilience Doesn’t give up easily 

Leadership Motivates and guides others 

Adaptability Adjusts to market changes 

https://canva.com/
https://behance.net/
https://trello.com/
https://notion.so/
https://www.hellobonsai.com/
https://clockify.me/
https://zoom.us/
https://drive.google.com/
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Vision Has long-term goals 

Integrity Honest and ethical in business 

Table 84: Characteristics of an Entrepreneur 

 

Types of Entrepreneurship 

Type Meaning Example 

Small Business 

Entrepreneurship 

Local or family-run businesses Retail shop, salon 

Startup Entrepreneurship Innovative business with growth 

potential 

Fintech, EdTech apps 

Social Entrepreneurship Focuses on solving social problems NGOs, impact projects 

Digital Entrepreneurship Online-based businesses eCommerce, YouTube, digital 

courses 

Freelance Entrepreneurship Self-employed professional 

services 

Graphic designer, online tutor 

Table 85: Types of Entrepreneurship 

 

Start a Business 

Step 1: Identify a Problem or Need 

Look around: what challenges can you solve? 

Example: People struggle with time management → Create an app. 

Step 2: Develop a Business Idea 

Outline how your product/service solves that problem. 

Step 3: Research Your Market 
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Who will buy from you? Who are your competitors? 

Step 4: Create a Business Plan 

Include: 

• Vision and goals 

• Target market 

• Marketing strategy 

• Budget and pricing 

Step 5: Register Your Business 

In Kenya → Use eCitizen to register your business name. 

Step 6: Build Your Brand 

Design a logo, choose colors, and create a consistent online presence. 

Step 7: Promote Your Business 

Use social media, YouTube, blogs, and word of mouth. 

Step 8: Manage Finances 

Track income and expenses using Google Sheets or QuickBooks. 

Step 9: Scale Up 

Grow your customer base, expand services, or hire help. 

 

Free Tools for Entrepreneurs 

Purpose Tool Website 

Business Planning Google Docs / Notion https://docs.google.com 

https://docs.google.com/
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Logo Design Canva https://canva.com 

Website Builder WordPress / Wix https://wordpress.com 

Marketing Mailchimp / Meta Business Suite https://mailchimp.com 

Financial Tracking Wave / Google Sheets https://www.waveapps.com 

Collaboration Slack / Trello https://slack.com 

Table 86: Free Tools for Entrepreneurs 

 

The Future of Work 

Technology is reshaping careers. Future opportunities depend on digital skills, creativity, and innovation. 

You don’t have to wait for a job: you can create your own path. 

 

 

 

 

High-Demand Digital Careers 

Field Opportunities 

AI & Data Science Data analysts, AI trainers 

Software Development App, web, and game developers 

Digital Marketing SEO, social media, branding experts 

Content Creation YouTubers, podcasters, bloggers 

E-Commerce Online shops, dropshipping, print-on-demand 

Design & Multimedia 3D design, animation, AR/VR 

Cybersecurity Protecting networks and systems 

https://canva.com/
https://wordpress.com/
https://mailchimp.com/
https://www.waveapps.com/
https://slack.com/
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Education Technology Online tutors, e-learning developers 

Virtual Assistance Remote business and admin support 

Table 87: High-Demand Digital Careers 

 

Soft Skills Needed for the Future 

Skill Why It Matters 

Communication Clear online collaboration 

Adaptability Technology keeps changing 

Critical Thinking Solve complex problems 

Creativity Develop new ideas 

Digital Literacy Navigate tools and AI systems 

Entrepreneurial Mindset Create opportunities 

Networking Build partnerships and clients 

Table 88: Soft Skills Needed for the Future 

 

Free Learning Platforms for Future Skills 

Platform Courses Available Website 

Coursera Tech, business, design https://www.coursera.org 

Google Digital Skills for Africa Digital marketing, freelancing https://learndigital.withgoogle.com 

LinkedIn Learning Career and leadership https://www.linkedin.com/learning 

Skillshare Creative and freelance skills https://www.skillshare.com 

YouTube Learning Tutorials and courses https://www.youtube.com/learning 

Table 89: Free Learning Platforms for Future Skills 

https://www.coursera.org/
https://learndigital.withgoogle.com/
https://www.linkedin.com/learning
https://www.skillshare.com/
https://www.youtube.com/learning
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AI and Automation Opportunities 

AI is creating new career paths, not just replacing jobs. 

Future creators can specialize in: 

• AI content creation (using tools like ChatGPT, Pika, Synthesia) 

• AI art and design (using Leonardo AI, Canva, Runway ML) 

• AI-driven marketing (using Jasper, Copy.ai) 

• Prompt engineering (crafting prompts for AI tools) 

 

Building a Personal Brand 

A personal brand is how people perceive you online. It builds trust, influence, and opportunities. 

Steps to Build It: 

1. Identify your niche (e.g., “Digital Skills Trainer”) 

2. Use the same profile photo across platforms 

3. Create consistent content 

4. Engage with your audience 

5. Show results or testimonials 

6. Use a portfolio site (e.g., Linktree, Notion) 

 

Future Opportunities in Africa & Beyond 

• Remote work for global companies 

• Digital entrepreneurship (apps, YouTube, online stores) 

• AgriTech and FinTech startups 

• Green innovation (eco-businesses) 

• Online education & training 

• Creative economy (art, design, media, music) 

The internet has made global opportunities local: if you can connect, you can compete. 

https://linktr.ee/
https://notion.so/

